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Thank you for your confidence in our products!

It is VERY IMPORTANT to carefully read this manual and to fully understand its contents

to maximize and get the best performance from this Software.

Latest version of the application is always available on our website www.ecler.com

= /

1. INTRODUCTION

EclerNet Manager is the software application that lets users build a digital audio system,
including hardware devices from the following product families: NXA Powered digital audio
managers, MIM0O88, MIMO88SG and MIM01212SG digital matrixes, MIMO4040DN /
MIMO4040CDN and MIMO7272DN Dante™ matrixes, DUO-NET PLAYER, PAGENETDN
Dante™ paging console, DN44BOB Dante™ audio interface, WPNET4KV, WPNET8K and
WPNETEX digital control wall panels, and WPNETTOUCH / WPmMSCREEN screen control

interfaces.

Using this software, it's possible to identify every device connected to the network and
configure it, together with the digital accessories that can be connected to it, like the
WPTOUCH / WPNET digital wall panels and the MPAGE16 / eMPAGE digital paging
stations.

Once the project file that stores this configuration is created and stored, the EclerNet
Manager application can also include UCPs (User Control Panels), which are graphical

control screens, customised for the needs of each remote user.

The EclerNet Manager software (running a project in a computer, a WPNETTOUCH, a
WPmMSCREEN, a PAGENETDN or a MIMO4040DN / MIMO4040CDN / MIMO7272DN unit)
includes a webserver allowing the remote-control devices (WPNETTOUCH, PAGENETDN,
WPMSCREEN, Windows® OS computers and tablets, Android® OS tablets and
smartphones, iPhones®, iPads®, etc.) become web clients, recalling and managing those

UCPs for an end user graphical, custom and friendly control experience.
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1.1 RELEASE NOTES

The current version of EclerNet Manager, at the time of writing this document (v6.01r4),
includes many improvements and modifications to make EclerNet platform more solid and

reliable, as well as these new features:

e Project & UCP web server supporting HTML5 format, as Adobe Flash support was

discontinued in most web browsers in January 2021

e MIMO4040DN CONFERENCE / MIMO4040CDN version support, including
Acoustic Echo Cancelling feature (AEC)

e Support for the new MIMO7272DN device (8x8 analog inputs / outputs + 64x64
Dante input / output ports)

e New flexible audio Inputs / Outputs routing for the MIMO4040DN and
MIMO4040DN CONFERENCE (MIMO4040CDN) and MIMO7272DN matrixes,
based on Input and Output Ports

e New tooltips system for inputs and outputs routing information in the
MIMO4040DN, MIMO4040CDN and MIMO7272DN matrixes

¢ Virtual controls management from TP-NET protocol for all MIMO matrixes

e Several UCP buttons can be stacked graphically on the screen, to allow for a batch

of actions with a single click on the upper (visible) button

¢ Digital events can be triggered by automatic audio signal detection, using a
DUCKER module as a trigger option in them (now available for MIMO4040DN,
MIMO4040CDN and MIMQ7272DN so far, and for the rest of MIMO models in the

near future)

e UCP panel page scrolling methods can be completely disabled, to create a closed
or guided panels’ browsing structure, just using PAGE LINK buttons (jumps among
UCP pages inside a panel)

e Secure mode included in UCPs, to activate the bottom HOME bar

e New EXTERNAL (or generic) kind of device can be added in an ENM project: it
allows to create standard UCP panels that employ NET String buttons to control
the EXTERNAL device, an entity that just has an IP address as its property in the
project. Just changing this IP address is enough to make the panel valid to control

any real external (not EclerNet native) HW device.

g . . . o)
I We encourage you to read this manual and to watch the video tutorials available

at our YouTube channel for a complete training concerning the software application and
hardware devices it can manage, as well as for full knowledge about EclerNet systems

\conﬁguration and control. )
N

For more information:

e Hardware / software User Manuals and software / firmware versions

e EclerNet Manager YouTube channel
g J

201

S31ON 3SV3INad
L)
NOILONAOYLNI

dvaiool
B
SNNAN

SMOANIM
ddv

NN3INW
1X31INOD

123rodd
SEINIETRE |

S321A3a
37191LVdWOD

(don) s1aNvd
T0Y1INOD ¥3SN



http://www.ecler.com/support/downloads/user-manuals.html
http://www.youtube.com/user/eclernetmanager

) ecLer

2. MENUS AND TOOLBAR

Following menus are available in the upper bar of the application window (matching

keyboard shortcuts are given inside brackets):

201

2.1 FILEMENU

e New (ctrl + N): opens a new Project.

E‘) EclerNet Manager - N
File Edit View Help

e Open (ctrl + O): opens a Project stored on a local hard

disk or other data storage unit. New erleM

S31ON 3SV3INad
L)
NOILONAOYLNI

e Save (ctrl + S): saves the current Project on a local hard Open... etrl + 0

disk or other data storage unit. Save etrl + 5

e Save As: a dialog box lets you save the current Project Save As..

with a different name and/or location. Recent Projects

dvaiool
B
SNNAN

e Recent Projects: displays a list of recently opened Exit

Projects and allows you to directly open one of them.

e Exit: closes the program.

SMOANIM
ddv

2.2 EDIT MENU

NN3INW
1X31INOD

¢ Add Device: adds a new device to the current Project. [EFEE N ETETI N M 4T

Parameters: Edit | View Help

Add Device...

Add Multiple Devices...
Add Device Group...
Add Channel Group...

o Device Type: selects in a list of compatible

123rodd
SEINIETRE |

EclerNet device types the one to add.

o Device Name: allows the new device to be

named. Delete delete 2 §
e Add Multiple Devices: adds several new devices to é g
the current Project. - @ @
Project Users... m
Parameters: Project Settings...
o Device Type: selects in a list of compatible Preferences.. > é
EclerNet device types the one to add. é E
o Number: number of devices to add. § 5
e Add Device Group: opens a dialog box to create a new device group in the current 22
Project. S
Parameters:

o Group Name: allows the new device group to be named.

You can create a group within a group (see section: EclerNet
~  PROJECT)
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e Add Channel Group: opens a dialog box to create a new channel group in the
current Project.

Parameters:

o Group Name: allows the new channel group to be named.

You can create a group within a group (see section: EclerNet
PROJECT)

o Delete (Delete key): allows a device, channel, device group or channel group to be

2’01

-_—

deleted from the Project. In order to remove a component, select it first (by mouse

or keyboard) in any application view.

S31O0N 3SVv3ITad
L)
NOILONAOYLNI

¢ Remove from Group: allows a device to be removed from a device group or a

channel to be removed from a channel group. In order to remove a component,
select it first (by mouse or keyboard) in any application view.

e Project Users: opens the configuration window for users and passwords (also

dvaiool
B
SNN3INW

accessible by clicking on the Users button in the toolbar).

Project Users

USER LIST
Administrator

SMOANIM
ddv

Advanced User

NN3IN
1X31INOD

123roydd
SEINIETRE

From this window you can create new generic users, delete or rename any existing ones

and change passwords for them and for the two default user profiles: Administrator and

(@]

Advanced User, which are blank by default. If passwords are assigned to one or another E %

user in a project, when trying to perform certain operations a password is requested in Q 5

n @©

order to be identified as Administrator or Advanced User. Thus, the project remains m
protected from any structural changes or operations made by users without such privileges

that could jeopardize the normal operation of the system. > é

+

0 g

s 3

30

o
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The following table summarizes the privileges of the three possible user profiles:

Administrator Advanced User Generic User
Auto-Lock YES YES NO
Lock YES YES NO
Design YES NO NO
Save YES NO NO
Save as YES NO NO
New YES NO NO
Load YES YES NO
Exit YES YES NO

As indicated, the Administrator has the highest rank in the privilege hierarchy, followed by
the Advanced User and generic users. All actions that may involve structural changes in a
project are enabled in DESIGN mode only, accessible to an Administrator only (add, delete
or rename devices, drag devices "online" in a project, save the project, open a new project,
save "presets", create carousel or event lists, add or edit remote controls, etc.). All these

operations are disabled in the different menus and controls when EclerNet Manager is in

DEPLOY mode (everyday use mode) (see section The toolbar), the only mode all other users

(advanced and generic) have access to.

e Project Settings: opens the project general settings window (also accessible by

clicking on the Settings button in the toolbar).

Project Settings
Power Sequencing Time

Enable Auto-Lock

Enable e-mail Notifications

¥ Enable Local Time/Date Update Automatically

Cancel

o Power Sequencing Time (0 to 5000 milliseconds): sets the power
sequence time delay between a device and following devices involved in the

Project.

2’01
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Enable Auto-Lock and Timeout (1 to 30 minutes): when you have assigned
a password to anyone of the high-level users (Administrator and/or
Advanced User), you may enter the protect mode of the project, either by
pressing the Lock toolbar button, or once "auto-lock" (automatic activation
of the protect mode) time out has passed without user activity on the Project
when the option Enable Auto-Lock is checked. To re-access the DEPLOY or
DESIGN mode, you must enter the password respectively assigned to the

Administrator or Advanced User.

Enable e-mail Notifications: enables/disables sending emails from the
specified address (From Address) and to the three possible specified
destinations (To Addresses) in the dialog box. Includes a "Test" button to

test this function operation (when pressed, a test e-mail is sent).

Enable Local Time/Date Update Automatically: allows the unit internal clock
to automatically sync with Windows time changes, an especially useful

function for daylight saving time.

Notes: (about e-mail sending)

O

O

The e-mails sent include the project name in their subject field.

To be able to send these e-mails, SMTP settings for the PC have to be done
in the Edit / Preferences menu.

There is a notice in the following cases:
Alarms

System Fault: for example, hardware failure (fuse, power supply...) of NPA

series amplifiers.

Coded errors (hardware, firmware, DSP...)

RTC (Real Time Clock) reset

When a device is disconnected from Ethernet.
When you load a Project if some device is missing.

For an event designed for this purpose (available in future versions).

201
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Preferences: opens general preferences window for the application.

e}

O

O

O

Preferences

Network Adapter ThinkPad OneLink Dock USE GigaLAN (10.0.1.15)

Synchronization Option Show Dia'log

SMTP Server
SMTP Port
SSL

SMTP Login

SMTP Password

Show This at Startup

Cancel

Network Adapter: allows to select the network card interface that EclerNet
Manager will use to discover and get online with the EclerNet hardware
devices. It's especially helpful when using a computer with more than one

network interface card (Wireless, RJ45, etc.).

I It'samustto select an option to be able to get online with hardware
devices in a network.

Synchronization Option: defines how a hardware device and its virtual
counterpart in the application will be synchronized when entering the online
mode. The options are:

= Get State from Physical Device: The Project is updated with data

from hardware devices at connection time.

= Send State to Physical Device: hardware devices are updated with

current Project data at connection time.

= Show Dialog: a dialog box appears each time to choose between
option 1 and 2.

e-mail Configuration (SMTP): configuration of the computer SMTP
parameters to enable sending e-mail notification of alarms, errors and
certain events registered in the application. Parameters: SMTP Server,
SMTP Port, SMTP Login, SMTP Password. If the SSL box is checked, it
enables the use of mail accounts with Secure Sockets Layer protocol (gmail,

hotmail, yahoo, etc.).

Show This at Startup: show this dialog box each time EclerNet Manager is
executed.

2’01
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2.3 VIEW MENU

e Show Devices: shows the devices view in the “Project  [vmm Help

Explorer”, “Groups from Device Container” and [T

“Members from Device Group:” windows. afaw Chan el
Show User Control Panels

e Show Channels: shows the Channels view in the

¢ : ¢ . | Exit Detail Mode ese
‘Project Explorer”, “Groups from Channel Container” |

Exit Design Mode

and “Members from Channel Group:” windows.
. Hide ToolBar
e Show User Control Panels: shows the view of the

Hide Project Explorer
remote-control screens created for UCP (User Control

Panels) or EclerNet Manager remote clients (see section USER CONTROL PANELS
(U.C.P.)).

e Enter Detail Mode (return) / Exit Detail Mode (esc): toggles detailed view of the
selected channel or device. The same function is performed by clicking on the Detail

icon in the upper right corner of the application window (u).

e Enter Design Mode / Exit Design Mode: enter / exit the application design mode.
The same function is performed by clicking on the Design and Deploy toolbar
buttons. All actions that may involve structural changes in a project are enabled in
DESIGN mode only (primarily used by installers and / or high-level users), whereas
DEPLOY mode can be considered as the system's daily management mode, not
associated with structural changes. Operations considered as structural changes in
a project are: add, delete or rename devices, drag devices "online" in a project, save
the project, open a new project, save "presets", create carousel or event lists, add
or edit remote controls, etc.).

e Show Toolbar / Hide Toolbar: shows/hides the toolbar under the menu bar.

e Show Project Explorer / Hide Project Explorer: shows/hides the Project browser
window on the left side of the screen. The same function is performed by clicking

on the Explorer toolbar button.

2.4 HELP MENU

e User Manual: displays this user manual.
e Visit the Ecler Web Site: direct access to

www.ecler.com.

er - NPA4000T Demo®

User Manual
e Report Logs: provides direct access to the folder Visit the Ecler Web Site

containing the system log files on your hard disk.
About...

e About.... displays the current version of EclerNet
Manager application.

201
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2.5 THETOOLBAR

The toolbar contains the following buttons for a direct access to functions:

rﬁ. Deploy _.'..!‘ Users _ﬁ_ Settings @ Panic - weCLer

2’01

e Explorer: same function as View -> Show Project Explorer / Hide Project Explorer
menu entry: shows/hides the Project browser window on the left side of the screen.

e Design/Deploy: same function as View -> Enter Design Mode/Exit Design Mode

S31ON 3SV3INad
L)
NOILONAOYLNI

menu entry: to enter/exit the application design mode. All actions that may involve

structural changes in a Project are enabled in DESIGN mode only (primarily used by
installers and/or high-level users), whereas DEPLOY mode can be considered as the

system's daily management mode, not associated with structural changes.

dvaiool
B
SNNAN

Operations considered as structural changes in a Project are: add, delete or rename
devices, drag devices "online" in a Project, save the Project, open a new Project,

save "Presets", create carousel or event lists, add or edit remote controls, etc.). 3
e Users: same function as Edit -> Project Users menu entry: opens the configuration § ]ﬁ
window for users and passwords (see section: Edit Menu) é
e Settings: same function as Edit -> Project Settings menu entry: opens the Project
general settings window (see section: Edit Menu) E %
e Lock: when you have assigned a password to anyone of the high-level users c g

(Administrator and/or Advanced User), you may enter the protect mode of the

project, either by pressing the Lock toolbar button, or once "auto-lock" (automatic

activation of the protect mode) time out has passed without user activity on the

123rodd
IBN43193

Project. To re-access the DEPLOY or DESIGN mode, you must enter the password

respectively assigned to the Administrator or Advanced User.

(@)
e Panic: activating it mutes all the output channels of the Project (absolute silence of E %
the system.) Deactivating it restores MUTES ON or OFF configuration as it was o} 5
L wE
before activation. m
e ECLER Logo: direct access to www.ecler.com
3G
z 5%
b3
= Z
5 3
J0
o
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3. APPLICATION WINDOWS

3.1 AVAILABLE WINDOWS

The following windows are available in EclerNet Manager:

2’01

e Project Explorer: Project explorer for [SREELOREIEEHERTNIIEITES
File Edit \View Help

devices, channels and device or channel === - —
= % oo

groups and control window design for

EclerNet Manager remote clients. It can be i

{1 groups)

S31ON 3SV3INad
L)
NOILONAOYLNI

enabled/disabled from the “View ->

b === Device 01

Show/Hide Project Explorer” menu or by
> Device 02

the Explorer toolbar icon

_‘
. . v i3 au (12) o z
e Project Explorer Helper: summary window, RGeS g o g
displayed at the bottom of the Project Device 01 - OUT 2 : OUTPUT 2 2 O
. De 01 - OUT OUTPUT 3
Explorer and showing: Device 01 - OUT 4 : OUTPUT 4
. . . . Device 01 - OUT 5 : OUTPUT §
o A list of all devices in the Project sl g
e 01 - OUT 6: OUTPUT & 4 >
(Device List) 0L - OUT 7 : OUTPUT 7 8 3
( e0l-OUT 8 : OUTPUT & E
. . . (n
o A list of all channels in the Project Wl3) Device 02 - CH1 : Channel 1
(Channe, L'St) == Online and Unused Device List (]
. . —— = — - \ < g
o A list of devices detected on the 101 LALA0L 235
PRESER! c Q
_‘

network and currently not used in

the Project (Online and Unused PRESERIE

10.11.12.17

Device List)

123rodd
IBN43193

o Properties of the item selected in the

Project Explorer (Properties)

6 [2011-02-10] [15:40:32] (Device)} (Device 02) Added to

S32IA3a
3791LVdWOD

‘ ~ Devices are identified in this window by their assigned name and IP address. ‘

The Project Explorer Helper can be displayed and hidden by clicking on the

L

triangle icon in the lower left corner of the Project Explorer.

[
gm

m
%:0
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3.2 DEVICE GROUPS DISPLAY WINDOWS

860

@ e [ecLer

o)
@

&

v 5 susGrouP AL

MIMOBE
01

NPA2500T
Device 10

>

@ [2011-02-10] [16:43:55] (Device) (Device 01) Device went offline 10/02/2011

e Groups from Device Container: shows all existing device groups

e Members from Device Group: shows all existing devices and/or subgroups inside

the group selected in the previous window.

When selecting a particular group (double-click or icon ), previous windows change
to display the contents of this group, as in the example after selecting “SUBGROUP A.1":

€) EclerNet Manager - New Project® [_Tolx]
File Edit View Help

=== Wooe & Gor O @ me  eCcLer

= Groups from Device Group : GROUP A

GROUP A
> @ Al T SUBGROUP A.1
v 5" GrROUP A
¥ "5 sus

PRESET
01 - Empty

€@ [2011-02-10] [16:40:36] (Device) (Device 01 (10.11.11.17:2210)) New Device found online 10/02/2011 16:43:46 4

icons are used to go back in the group structure towards its root or the upper
group container. Selecting a group in the Project Explorer also updates its detail windows.

You can create groups within groups (subgroups), as shown in the picture above.

=

To include a device within a group, you must drag and drop it from its location onto the
group. More information about this in chapter EclerNet PROJECT.
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3.3 CHANNEL GROUPS DISPLAY WINDOWS

(®) EclerNet Manager - New Project® [_JoIx]
Edit View Help

% ErEm EEEE = oo Toe O e ecLer

— Project Explorer O

("]
&

0008 | o0ds

| &

Mer rs from Channe Al
Fornnei [ ramer 2 Cranne ] s Joutrur oureurs Joutrur s ourrura Jourrur sYourer s Jouteyr s ourrura] cramer ] crannes

" ImEEB

>

© [2011-02-10] [17:13:43] (Channel) (Device 10: Channel 1) Added to Channel Group "Subgroup kitchen" 10/02/2011

e Groups from Channel Container: shows all existing channel groups.

e Members from Channel Group: shows all existing channels and/or subgroups

within the group selected in the previous window.

When selecting a particular group (double-click or icon), previous windows change to

display the contents of this group, as in the example after selecting “Group ch Floor”:

& EclerNet Manager - New Project* [_Jolx)
View  Help

B oer e aliar @ we JecLer

Project Explorer &t

D
Cl

» B

- OUT 7: OUTPUT 7
- OUT 8: OUTPUT 8

>

@ [2011-02-10] [17:13:43] (Channel) (Device 10: Channel 1) Added to Channel Group "Subgroup kitchen" 10/02/2011 17:1957 (4

& L § . .
- icons are used to go back in the group structure towards its root or the upper group
container. Selecting a group in the Project Explorer also updates its detail windows.

103roydd NN3NW SMOANIM
1X31NOD

S32IA3a
3791LVdWOD

-
>
z
m
m
()
c
o

2

S310N 3SVv3I3d
B

d4vaiool
B

2’01

NOILONAOYLNI

SNN3INW

ddv

SEINIETRE

TOYHLNOD H3sn



) ecLer

You can create groups within groups (subgroups), as shown in the picture above. To
include a device within a group, you must drag and drop it from its location onto the group.
See section: EclerNet PROJECT.

Clicking on the “Show / Hide More Information” icon E in the lower right corner

of the screen expands each channel viewing area with extra information, and two

2’01

new icons appear above the previous one

v

S31ON 3SV3INad
L)
NOILONAOYLNI

With the two new icons, you can select units (volts or watts) and scale (RMS or peak) used

dvaiool
B
SNNAN

to display the LED metering of the channel output signal (amplified) (function available with
NPA series).

Channel 2 Channel 2
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Device: device detailed display window, appearing only when Detail n mode is
enabled. Shows all general controls for the device and/or one or more device

channels (input selection, output configuration, network settings, DSP, monitoring,

2’01

etc.)

AMPLIFIER 3 =
STEREQ
SINEWAVE & OFF

SOFT
50V

MANUAL ---
0.0 .i‘
2210 ALK

MmN MAK
< 0.0.0.0 ATTEMUATION

S31ON 3SV3INad
L)
NOILONAOYLNI

Fi Ql_llel:"r:.
1.000 Hz OPERATING TIME == - C ¥ 0.0.0.0

CROSSOVER & COMPRESSOR  MONITOR
LOW-PASS HIGH-PAS .0 - T

YPE

dvaiool
B
SNNAN

20 n* 20k
FREQUENCY FREQUEMNCY

|
RATIO

& PARAMETRIC EQ W s

i / PEAK

SMOANIM
ddv

' £l ' ®

e Cwaowme Chax + GONFIG

ATTACK RELEASE

NN3INW
1X31INOD

DELAY e WVPEAK LIMITER
N OFF

n* 2k M MAX M e
FREQUENCY GAIN Q " AK MmN 0,

0ooms % max 00,0

123rodd
IBN43193

Ventana Device para un dispositivo de la serie NPA

(@)

. o2

There are several ways to turn on/off the Detail mode: S

o3

o Clicking on the Detail ( ) icon in the upper right corner m
o From the “View -> Enter/Exit Detail Mode” menu entry

o C

o Double clicking on a device or channel in any of the Project windows z %

Mo

o Pressing Return or Esc after a channel or device selection in any of the g e

_‘

Project windows 83

o




) ecLer

When the Detail mode is activated, the following icons appear in the lower right

corner of the screen:
o Show / Hide Channel 1: shows/hides channel 1 controls for the

selected device (1]

o Show / Hide Channel 2: shows/hides channel 2 controls for the ?
selected device...

o Show / Hide Channel n: ditto the above for channel n, in NZA devices with
4 or 6 channels

o Show / Hide Graph: shows/hides a window graphically displaying the
frequency-response curves resulting from crossovers and equalization
applied to the corresponding channel by DSP processing (see section:

Detailed view).

e Report Log: shows arecord of major operations performed on the Project over time.

Report Log

Name Description
DELAY REINFORCEMENT Name :

FULL SHOW Name
MAIN PA Name
REDUNDANT SYSTEM

STAGE MONITORS

Device 04

Added to Device Group "MAIN PA"

€@ [2003-04-29] [08:33:00] (Device) (FRONT PA) Power ON

Shown/hidden by clicking on the triangle icon in the lower right corner of the EclerNet

Manager screen.

The complete Report Log is stored as a text file on the hard disk. Report Logs option from
the Help menu gives direct access to the folder containing log files or "report logs"

generated since the system start-up.

29/04/2009 8:45:31 A
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A separate file is created for each day of use (the file name includes the date). If you run

and quit the application several times a day, this is reported in the file.

B Manager, 2009-04-29 - Notepad

File Edit Format Wiew Help

—————— - - - - - -

Log started: 2009-04-29 at 10:41:30 o

______ I - I o

[2009-04-25] "application” "Eclernet Manager” "application started" :

[2005-04-29] "Project” "New Project" "Mew project file created’|

[2009-04-29] "Device" "AMPLIFIER 2" "added to Dewvice Group "DELAY REIMFORCEMENT™"

[2008-04-29] "Device" "aMPLIFIER 2" "mremowved from Dewice Group "DELAY REIMFORCEMENT™" o =

[2009-04-29] "Deyvice" "Device 04" "added to Project” m r4

[2000-04-20] "Device" "Device 04" "added to Dewice Group "FULL SHOw'" E ;_U|

[2000-04-2G] "Deyice" "Device 05" "added to Pruject" > o

[2009-04-25] "Device" "Device 05" "added to Dewice Group "FULL SHOW'! n o

[2000-04-2G] "Deyice" "Device 06" "added to Pruject" m @ =

[2009-04-25] "Device" "Device 06" "added to Dewice Group "FULL SHOW'! 4 0

[2000-04-20] "Device" "Device 07" "added to Project” o |

[2009-04-29] "Device" "Device 07" "added to Dewice Group "FULL SHOW'! ; o

[2000-04-20] "Deyice" "Device 08" "added to Project” 7)) z

[2009-04-29] "Device" "Device 08" "added to Dewice Group "FULL SHOW'!

[2000-04-20] "Deyice" "Device 09" "added to iject"

[2009-04-29] "Device" "Device 09" "added to Device Group "FULL SHOW'!

[2000-04-20] "Deyice" "Device 10" "added to Project”

[2009-04-29] "Device"” "Device 10" "Added to Dewlce Group "FULL SHOW'" -

[2000-04-20] "Deyice" "Device 11" "added to Project” (@) Z

[2009-04-29] "Device” "Device 11" "Added to Dewlce Group "FULL SHOW'" (@] m

[2000-04-20] "Device” "Device 12" "added to Project” 5 I é
v

< > % «w

3
Z>
O3
3.4 GRAPHIC/TABLE DISPLAY MODES g °
()]
Groups and channels windows can be viewed in graphic format (reflecting images 5
shown in the previous paragraph) or as a table by clicking on the dedicated icons in Z %
Z
the upper right part of the screen (these icons are visible only when Detail mode is [z c g

off).

— Device Groups
Name A #Devices
All 9

DELAY REINFORCEMENT

FULL SHOW

123rodd
IBN43193

(@]

o

B =

S5

a4

b m

-

m

Devices from Group: FULL SHOW + 0 %

a Model MAC IP Address DELAY REINF.. FULL SHOW MAINPA  REDUNDANT.. STAGE MONL.. > m

NPAZ500T 0.0.00 & o Z XD

NPA4000T v o p Q

! NPA400OT .| n O

AMPLIFIER 5 NPA4000T b7, —_Z

AMPLIFIER 6 NPA400OT | C —

AMPLIFIER 7 NPA4000T v O X

FRONT PA. NPA4000T vl 0 o

SM AMPLIFIER A NPA400OT v ~ r
SM AMPLIFIER B NPA4000T 0000 b,

Table mode view
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From the table mode view, you can add or remove devices or channels to/from

existing groups by clicking on the corresponding check box.

. . . . —
To select the columns displayed in the table place the cursor on the table title bar and right- o
. 0
click.
x —
" Model E E
MAC > o
" IP Address 0 (w)
UDP Port m & c
z 0
= Devices from Group: FULL SHOW e 9| |
N Gateway m @]
ame IS Model MAC — FULL SHOW MAIN PA w0 4
AMPLIFIER 2 NPA2500 [ vl
AMPLIFIER 3 v
AMPLIFIER 4
_‘
o <
To reverse the alphabetical listing order, left-click on any table header. ey
w Cc
> n
o
Name Name ¥
AMPLIFIER 2 SM AMPLIFIER B
AMPLIFIER 3 SM AMPLIFIER A s
AMPLIFIER 4 FRONT PA E >
93
AMPLIFIER AMPLIFIER 7 o1
AMPLIFIER 6 AMPLIFIER 6 cén
AMPLIFIER 7 AMPLIFIER
FRONT PA AMPLIFIER ¢
SM AMPLIFIER A AMPLIFIER 3 z 8
SM AMPLIFIER B AMPLIFIER 2 g 5
cx
_‘
Ascending alphabetical order view/Descending alphabetical order view
o
2 a
Oe
m
Qs
DELAY REINFORCEMENT _| lad
FULL SHOW
MAIN PA U 8
<
REDUNDANT SYSTEM 2 0
a3
STAGE MONITORS a o
z
m
= Devices from Group: FULL SHOW
o S
[0l
NPA2500T > m
AMPLIFIER 2 % m
S b 8
NPA4000T —_ 2Z
AMPLIFIER 4 % 5‘
NPA400OT J 0
AMPLIFIER 5 -
NPA4000T

AMPLIFIER &

NPA4D0OT
AMPLIFIER 7

NPA4000T
FRONT PA

NPA4000T
SM AMPLIFIER A

NPA400OT
SM AMPLIFIER B

Graphic mode view




4. CONTEXT MENU: RIGHT MOUSE BUTTON

) ecLer

Right-clicking on various Project elements will open a context menu with possible actions

for each case.

4.1 DEVICE CONTEXT MENU

Available from any device view (Project Explorer, Project Explorer Helper, Groups window,

etc.).

Options:

Rename (F2): renames device.

Edit Comments: allows a brief comment about
the device to be added/modified (configuration,
role in the Project, etc.) These comments can be
viewed from EclerNet Manager, placing the
cursor over a device or channel (or from the
hardware device itself with NPA Series: see NPA
series hardware manual for more details.)

Delete: totally removes the device from the

Rename...
Edit Comments...

Delete

Move Up

Activate Device Finder

Metwork Configuration...

Change Password..

Project. If the virtual device was associated with

. ) DI

a hardware device on the network, this last one 'Sm:"“t
Detac

will appear in the “Online and Unused Device

List” from Project Explorer Helper after its Firmware Upgrade...

deletion. Rebout
Remove from Group: removes the device from the group the context menu has
been opened for.
Move Up (ctrl + T): moves up the selected device (changes the order within a
group).
Move Down (ctrl + {): moves down the selected device (changes the order within
a group).
Activate / Deactivate Device Finder: activates/deactivates the blinking of the front
panel light indicators (LCD display for NPA series, LEDs for NXA series, MIMO88,
MIMO88SG and other devices) on targeted hardware, thus allowing easy
identification on site. Simultaneously, the frame of the device shown in EclerNet
Manager windows also blinks, making it possible to link a virtual device of the Project
with its hardware equivalent, for example to configure its network settings or to
check its identity before changing its settings.
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Network Configuration: allows Ethernet [ Network Configuration
parameters to be entered (and verified later) for Device "Basement AMP #1"
the related device (IP address, subnet mask,
gateway and UDP port). The MAC address is a

read-only parameter, unique and assigned by

Ethernet MAC 00-00-00-00-00-00
IP Address 192.168.0.100

. IP Subnet Mask 255.255.0.0
the manufacturer to any Ethernet device.

IP Gateway 192.168.0.1

Change Password: allows the password to be
. . UDP Port 2210
assigned or changed in order to protect the
device. When a device has this type of password
(blank per default = OFF) assigned in a Project,
the device cannot be re-programmed from other Projects unless you enter the
correct password. Any change in the new Project will not be effective in the

hardware device until password is entered, and it's indicated in the device status

window by an exclamation mark on the connection indicator (E) and the flashing

E icon)

Connect/ Disconnect: connects (or disconnects) the device to the network, to make
it available for remote control from EclerNet Manager.

Detach: breaks the link between an EclerNet virtual device and its physical
counterpart. The hardware device, if detected "online" on the network, becomes
part of the “Online and Unused Device List” in the Project Explorer Helper window.
Firmware Upgrade: opens a dialog box that allows you to load a device firmware
file (with .bin extension) and to transfer it to the related device. The device must be
"online" to perform this operation.

Reboot: resets the device, following the usual boot sequence.

2’01
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4.2 CHANNEL CONTEXT MENU

Available from any channel view (Project Explorer, Project Explorer Helper, Groups

window, etc.).

: -
Options: o)
8]
e Rename (F2): allows the channel to be Sr— —
renamed. Edit Comments...

Remove from Group delete

¢ Edit Comments: allows a brief comment about
the channel to be added/modified

(configuration, role in the Project, etc.).

Go to Device

S31ON 3SV3INad
L)
NOILONAOYLNI

Move Up ctrl + up

Move Down ctrl + down

¢ Remove from Group: removes the channel from
the group the context menu has been opened for.

e Go to Device: automatically selects the device the targeted channel belongs to,

dvaiool
B
SNNAN

showing it in the currently active windows (graphic or table).

e Move Up (ctrl + T): moves up the selected channel (changes the order within a s
group). § %
e Move Down (ctrl + {): moves down the selected channel (changes the order within ?n
a group).
z O
03
cx
_|
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4.3 DEVICE GROUP CONTEXT MENU

Available from any device group view (Project Explorer, Groups window).

Options:

Rename (F2): allows the device group to be RRBATE

Edit Comments...
renamed.

Delete
Edit Comments: allows a brief comment about the Add Divice..
device group to be added/modified (configuration, Add Multiple Devices..
role in the Project, etc.). Add Device Group...

Empty

Delete: totally removes the group from the Project.

Add Device: adds a new device to the group and

Mowve Down curl + down

therefore to the Project.
. . . Connect All
Add Multiple Devices: adds several new devices to

the current Project. Activate Device Finder

Deactivate Device Finder
Parameters:

o Device Type: selects in a list of compatible EclerNet device types the one to
add.

o Number: number of devices to add.

Add Device Group: opens a dialog box to create a new device group in the current

Project.
Parameters:

o Group Name: allows the new device group to be named.

¥ You can create a group within a group (see section EclerNet
PROJECT)

Empty: removes all devices from the group, leaving it empty.
Move Up (ctrl + T): moves up the selected group (changes the order).
Move Down (ctrl + {): moves down the selected group (changes the order).

Connect All: connects all group devices to the network, so they become available
for remote control from EclerNet Manager.

Activate Device Finder: enables the Device Finder for all online devices within the
group.

Deactivate Device Finder: disables the Device Finder for all online devices within
the group.

201
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4.4 CHANNEL GROUP CONTEXT MENU

) ecLer

Available from any channel group view (Project Explorer, Groups window).

Options:

1.

Rename (F2): allows the channel group

to be renamed.

Rename...

Edit Comments...

Delete delee

Add Channel Group...

Empty

Add Channel Group: opens a dialog box to create a new channel group in the

2. Edit Comments: allows a brief comment
about the channel group to be
added/modified (configuration, role in the
Project, etc.).

3. Delete: totally removes the group from
the Project.

4.
current Project.

Parameters:

o Group Name: allows the new channel group to be named.

= You can create a group within a group (see section EclerNet PROJECT)

5. Empty: removes all channels from the group, leaving it empty.

6. Move Up (ctrl + T): moves up the selected group (changes the order).

7. Move Down (ctrl + 1): moves down the selected group (changes the order).

201
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5. EclerNet PROJECT

A Project is a configuration and remote-control file for EclerNet device network. It contains
a number of EclerNet virtual devices, structured according to a hierarchical arrangement of

control groups for such devices and/or for their audio channels.

The purpose of a Project, once online, is to configure, remotely control and monitor a
number of hardware devices connected to an Ethernet network. The network can include
any combination of EclerNet compatible devices: NZA series amplifiers, NPA series
amplifiers, MIMO88, MIMO88SG, MIMO1212SG, MIMO7272DN and MIMO4040CDN
digital matrixes, DUO-NET PLAYER, etc.

The created file has the .enp extension and must be opened and operated from the

EclerNet Manager application.

A Project can be created and edited offline, without being connected to the site Ethernet
network, and later turned to online or real system management mode from a PC connected

to the same network EclerNet compatible devices are connected to.

REMOTE COMTROL PC
(running EclerMet Manager)

Example of EclerNet network including NZA, NPA and MIMOS88 devices, the computer running EclerNet
Manager and Ethernet network infrastructure that interconnects them.

2’01
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5.1 CREATING AN ECLERNET PROJECT

The steps for setting up a Project from scratch are:

5.1.1 OPENING OF A NEW FILE

) ecLer

File -> New menu entry (or Ctrl + N keyboard shortcut). The default new Project window

appears, looking like the following:

(9 EclerNet Manager - New Project
File Edit View Help

== f B 6 0 g
- lE Explorer Fﬁ. Deploy L. users f} Settings

Devices (1 groups)

| All
5

= Members from Device Group : All

Members from Device Group : All

6 [2011-02-14] [14:06:52] (Device) (NO LABEL (10.11.11.231:2210)) New Device found online

5.1.2 INSERTION OF NEW DEVICES IN THE PROJECT

_Lof>x)

© e [UecLer

D
=

14/02/2011 140729 4

Edit -> Add Device menu entry. A dialog box opens to select the device type and assign it

a custom name:

_—= B B ]
- . i ! v L ce atti
.E [xn!urnr_ yli= Design ﬂ. Deploy B Users ﬂ Settings

F ect Explorer
evices (1 groups)

{0 designs)

Add New Device

Device Type MI MO‘éB‘

Device Name Device 01

Cancel

6 [2011-02-14] [14:06:52] (Device) (NO LABEL (10.11.11.231:2210)) New Device found online

® e [YecLer

[t
=

14/02/2011 14:08:59 4
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After clicking OK, the new device appears in the various Project windows:

Project Explorer
Project Explorer Helper
Groups from Device Container or Groups from Channel Container

P WNPR

Members from Device Group or Members from Channel Group

E} EclerNet Manager - New Project” e G) O
File Edit View Help

:é- EE: Deploy X users Q Settings @ Panic ueCLer

Project Explorer )

> @ A

14/02/2011 1412:38 (4

6} EclerNet Manager - New Project* e@m
File Edit View Help

=5 BB ooy | B Users || £F Setwings @ e [UecLer

Project Explorer )

7o)
®

€ [2011-02-14] [14:11:08] (Device) (Device 01) Added to Project 14/02/2011 14:13:35

Added devices automatically appear in the “All” device and channel default groups, which
respectively contain all the Project devices and channels. You can also add devices to the

Project by right-clicking on a device group (Add Device option in the context menu).
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5.1.3 FACTORY PRESET NETWORK SETTINGS

The factory default network settings for EclerNet Manager compatible devices are as

follows:
e |P: 192.168.0.100
¢ Mask: 255.255.255.0
e Gate: 192.168.0.1

e UDP Port: 2210

5.1.4 CREATING A DEVICE GROUP.

There are two ways to create a device group:

1. Edit -> Add Device Group menu entry
2. Right-clicking on Devices in Project Explorer and Add Device Group option in the
context menu

"

vy = Project "Manua

Add New Device Group

* T B{"
» (w8 ] BY
» [ & | Fil
» [ 8] Fif
» [ & ] O 0K Cancel

[T 1 ) S

Group Name Basement AMPS

After their creation, the new groups appear in the corresponding Project windows.

plorer = | = Groups from Device Container
v = project "Manual”

=5 All
v {5 Devices (3 groups)

Basement AMPS

» [ & | Basement AMP #1
» [ =] Basement AMP #2 N o First Floor AMPS
» [ =] First Floor AMP #1

» [ B | First Floor AMP #2

» [ 8| Outdoor Zone 1 AMP #1

» [ & | Outdoor Zone 2 AMP #2

» [ B2 | Outdoor Zone 3 AMP #3

> |I| Safety Perimeter AMP #1

> m Safety Perimeter AMP #2

> |I| Safety Perimeter AMP #3

» [ & | Second Floor AMP #1

» [ 8 | Second Floor AMP #2

» [ Bl | Technical Spaces AMP #1

> |I| Technical Spaces AMP #2

> |I| Technical Spaces AMP #3

? Basement AMPS

5" First Floor AMPS

» = Channels (1 groups)

103roydd NN3NW SMOANIM
1X31NOD

S32IA3a
3791LVdWOD

-
>
Z
m
r
"
c
(@]

3

S310N 3SVv3I3d
B

d4vaiool
B

2’01

NOILONAOYLNI

SNN3INW

ddv

SEINIETRE

TOYLNOD d3sn



) ecLer

You can also create groups within groups:

- = r
=) E Explorer Design fﬁ_ Deploy 2B users 1:]- Settings

2’01

Add New Device Group

S31O0N 3SVv3ITad
L)
NOILONAOYLNI

Group Name Subgroup AMP 1.!4!

Cancel

dvaiool
B
SNN3INW

Assigning a device to a group of devices is as simple as dragging it from any window and ; >
|w)

dropping it in any window displaying the group. A green frame appears indicating that the g 3
destination of the drag and drop operation is validated and included in the Project. e

The table mode view is another way to assign, where a device can be included or excluded z §

in/from a device group by directly clicking on the column with the group name. g ﬁ

_|

Example: different ways to assign the “Basement AMP #1” device to the “Basement
AMPS” group:

123roydd
SEINIETRE

(’:“) EclerNet Manager - Manual®
File Edit View Help

-
El Explorer

0
92
= Project Explorer 2 o
v " prgject "Manual” 9 ]_>|
v (= Devices (3 groups) | | o IEE
m
v @ Al R T il Device "Basement AM o
» [ &l | Basement AMP #1
»> &l | Basement AMP #2 N First Floor AMPS C
» Bl ] First Floor AMP #1 g ‘I_fn)
» [_mal_] First Floor AMP #2 % o
(@)
» | Bl | Outdoor Zone 1 AMP #1 6 O
- Z
c 4
(@l ]
o)
=
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(®) EclerNet Manager - Manual*
File Edit View Help

D
E Explorer
.

= Project Explorer

v SE Praject "Manual”

L4 ""%l Devices (3 groups)
v {3 Al
» [ & | Basement AMP #1
v [ & | Basement AMP #2 First Floor

2’01

if|3) CHL : Channel 1
if|3) CH2 : Channel 2

x —
- m z
B | First Floor AMP #1 - 3
&) First Floor AMP #2 ; 8
&l | Qutdoor Zone 1 AMP #1 % (w)
Bl | Outdoor Zone 2 AMP #2 z & %
i | Outdoor Zone 3 AMP #3 O =
Bl | Safety Perimeter AMP #1 H %
Bl | Safety Perimeter AMP #2 (2
| Safety Perimeter AMP #3
» [ &8 | Second Floor AMP #1 e
] Second Floor AMP #2 NPA4000T 4
First Floo
Bl | Technical Spaces AMP #1 rst Hoor (@] <
e i 42 NPA400OT o m
Bl | Technical Spaces AMP #2 T - @ Z
Bl | Technical Spaces AMP #3 i-; [
— B - NPA40OOT n
L e B B B Device "Basement AMP #1' Outdoor 2 o
F5% First Floor AMPS
NPA400OT
| Second Floor AMP #1 Z >
] Second Floor AMP #2 8 I
| Technical Spaces AMP #1 E
— ()]
Bl | Technical Spaces AMP #2
Bl | Technical Spaces AMP #3
0
z O
P5® First Floor AMPS m 3
e A m
> '_?\- Channels (1 groups) c X
3

= Device List

Basement AMP #1

123roydd
SEINIETRE

| Basement AMP #2

(@]
92
A device group provides both management and supervision (from the group control g 2
_‘
interface) of some controls concerning all devices in the same group (e.g. to sequentially h @
m
turn on/off all group amplifiers by pressing the group POWER key).
25
First Floor AMPS ]z> o
-3
= Z
s 3
22

:First Floor AMPS

NP&4000T E
Fi Floor 01 - Empty

NPASODOT E
First Floor AMP #2
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5.1.5 CREATING A CHANNEL GROUP
There are two ways to create a channel group:

1. Edit -> Add Channel Group menu entry
2. Right-clicking on Channels in Project Explorer and Add Channel Group option in the

2’01

context menu

- B —

n Channe
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= Basement LEF Add New Channel Group
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Group Name Basement AMPsl

Cancel

SMOANIM
ddv
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After creation, new groups appear in the corresponding Project windows.

@ EclerNet Manager - New Project®
File Edit View Help

- W — - =
= kE Explorer EF:: Deploy X users 1:,( Settings
& A

= Project Explorer
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(= ouT 7 : OUTPUT 7
OUTPUT 8
v M5 GRUP AMP1
h|;|' Subgroup AMP 1A
h|;;' Subgroup AMP 1A
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As with device groups you can also create channel groups within other channel groups.

Assigning channels to a channel group is done using the same “drag and drop” procedure
already described for the device assignment to device groups.

Similarly, it is possible to achieve this in a very practical way with table mode.
Examples of different ways of assigning a channel to a channel group:

= Project Explorer —r—+—+——————— Channel Groups

v “*#* project "Manual”
v & Devices (3 groups)
. B Al )
> ? Basement AMPS
» P57 First Floor AMPS

v "'PF;i Channels
v

& an
Basement AMP #2 - CH1: Channel 1
Basement AMP #2 - CH2 : Channel 2
First Floor AMP #1 - CH1 : Channel 1
First Floor AMP #1 - CH2 : Channel 2
First Floor AMP #2 - CH1 : Channel 1
First Floor AMP #2 - CH2 : Channel 2
Outdoor Zone 1 AMP #1 - CH1 : Channel 1
Outdoor Zone 1 AMP #1 - CH2 : Channel 2

-m

0,0dB 0,0dB 0,0dB

echnical Spaces AMP #1 - CH2 : Channel 2
echnical Spaces AMP #2 - CH1 : Channel 1
echnical Spaces AMP #2 - CH2 : Channel 2
echnical Spaces AMP #3 - CH1 : Channel 1
echnical Spaces AMP #3 - CH2 : Channel 2
asement AMP #1 - CH1 : Channel 1
Basement AMP #1 - CHZ : Channel 2

el A AR LB Channel "Channel 2"

h Basement RIGHT side ch
v "‘—P:- Channels

P Basement RIGHT side ch

0,0dB 0,0dB 0,0 dB
|

B}l Channel "Channel 1"

= Channel List
if|3)) Basement AMP #1 - CH1 : Channel 1
i3] Basement AMP #1 - CH2 : Channel 2
| Basement AMP #2 - CH1 : Channel 1
| Basement AMP #2 - CH2 : Channel 2
| First Floor AMP #1 - CH1 : Channel 1
)] First Floor AMP #1 - CH2 : Channel 2
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A channel group provides both management and supervision (from the group control
interface) of some controls concerning all channels in the same group (e.g. to vary the
volume or enable/disable MUTE or SOLO for all group channels by pressing the group M or
S key).
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5.1.6 IDENTIFICATION OF NETWORKED DEVICES

It's a must to select an option in the Edit -> Preferences -> Network Adapter

menu to be able to discover and/or get online with hardware devices in a network.

2’01

Preferences

Network Adapter ThinkPad OneLink Dock USE GigalLAN (10.0.1.15)

Synchronization Option Show Dialog

S31O0N 3SVv3ITad
L)
NOILONAOYLNI

There are two methods to identify a Project device with its hardware counterpart on the

network:

dvaiool
B
SNN3INW

1. Configuration of device network parameters.

Using the Network Configuration option in the device context menu (right-click),

you obtain network parameters that uniquely identify the hardware device s
. . Z
configured with exactly the same parameters: Sz
3
Project Explorer
TEE o " " (@]
v Project "Manual z g
v 'Jf'_%- Devices {3 groups) g l_—nl
¥ ? All (15 5 >—<|
» [ & | Basement AMPES Network Configuration Tm
> | First Floor AMH 3 &
» [ &8 | First Floor AMH Device "Basement AMP #1" 5 g
(88| Outdoor Zone | gpernet MAC 00-00-00-00-00-00
| Outdoor Zone | a
—I — IP Address |192.168.0.100] o 9
—— ) <
| safety Perimet{  IP Subnet Mask [255.255.0.0 o Zg'
- m =
| Safety Perimet{ » @
—— ) IP Gateway 192.168.0.1 m
| Safety Perimet{
| Second Floor A UDP Port 2210
| Second Floor A g é
| Technical Spaci E (;g
| Technical Spac| o (ZJ
— c 5
oOx
o)
o

If there is no hardware device with the entered IP address in the network, selecting

Connect from the context menu won’t establish the connection between the device

and EclerNet Manager (blinking red connection icon).
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If there is such a device in the network, selecting Connect from the context menu
opens the synchronization window which allows the Project virtual device current
status to be sent to the hardware device, or the reverse: updating the Project virtual
device status with the hardware device actual status. Once connection has been
established (blinking green connection icon), the device is removed from the “Online

and Unused Device List” in Project Explorer Helper.

Once synchronized, the device appears in EclerNet Manager with its green

connection icon lit.

Direct identification with an online device.

The Project Explorer Helper window (Online and Unused Device List) displays all
devices detected on the network and not assigned to Project virtual devices. You
can use the “drag and drop” method to associate each one with its virtual

counterpart in the Project:

(®) EclerNet Manager - Manual®
File Edit View Help

Project Explorer
v "% project "Manual”

v f’? Devices (3 groups)

(17 d <
I~ % Device "MAIN P

| &8 | Basement AMP #I T
)l CH1 : Channel 1
CH2 : Channel 2
| Basement AMP #2
CH1 : Channel 1
CH2 : Channel 2
| First Floor AMP #1
| First Floor AMP #2
| MAIN PA
| MAIN PA
| Outdoor Zone 1 AMP #1

[ B | Outdoor Zone 2 AMP #2
[ =8 | Outdoor Zone 3 AMP #3
—| Safety Perimeter AMP #1
_I Safety Perimeter AMP #2
[ = | Safety Perimeter AMP #3
[ & | Second Floor AMP #1

» [ &8 | Second Floor AMP #2

ol
N
| b
| el
N

= Online and Unused Device List

MAIN PA

10.0.100.9 : 2210 REA SO

After release, a window appears asking you to confirm the link between the
hardware device and the Project virtual device. After confirmation, the device
disappears from the “Online and Unused Device List” and a blinking red icon
appears, indicating that connection is not established.

103rodd NN3INW SMOANIM
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You can also drag an existing device from the Project Explorer Helper (Online and
Unused Device List) and drop it directly on the device group “All” or any other device

group of the Project to include it:

2’01

:OUTPUT 1
s OUTPUT 2
:OUTPUT 3
:OUTPUT 4

S31O0N 3SVv3ITad
L)
NOILONAOYLNI

: OUTPUT 5

JUTPUT 6

v F5" GRUP AMP1
ho‘ Subgroup AMP 1A

dvaiool
B
SNN3INW

= Online and Unused Device List ASEHRnLL Gl S
=5 I;‘I:? S 0L 2210
g
Z >
O3
o
3
Or even add to the project all devices of the network by clicking on the "+" button
located in the upper right corner of Project Explorer Helper: o
Z2
Zd
c X
_|

123roydd
SEINIETRE

[1:0UTPUT 1
OUTPUT 2
TP 3
{OUTPUT 4 8
: OUTPUT 5 g Z
OQUTPUT 6 < g
OUTPUT 7 i | Q =
. 00d6 || o008 || 7)) o
8:OUTPUT B | -
m
? Subgroup AMP 1A
? Subgroup AMP 1A
; = c
Add Online Devices to Project g (2]
m
Z XD
o
Do you want to add all Online Devices to 6 o
Project? - 2Z
c 4
O x
J O
P

&

Device identification can be cancelled using the Detach option in the context

menu.
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I, ALLOCATION OF NETWORK PARAMETERS

EclerNet compatible devices (MIMO88, MIMO88SG, MIM01212SG, MIMO4040DN,
DUO-NET PLAYER, NXA, DUO-NET, NZA, NPA, etc.) do not support dynamic
allocation protocol for network addresses, or DHCP, ie: they can't dynamically negotiate
IP addresses and require manually configured and fixed IP addresses. It is highly
recommended that both EclerNet devices (MIMO88, MIM0O88SG, MIM0O1212SG,
MIMO4040DN, DUO-NET PLAYER, NZA, NPA, etc.) and the computer running EclerNet
Manager are configured with static network addresses from the same range in order to

have a full connectivity between all of them.

An example of a small local network of this type may have the following network settings
in its EclerNet devices:

DEVICE IP ADDRESS | IP SUBNET MASK
MIMO8S (first floor) 10.5.5.10 255.255.255.0
MIMO88 (second floor) 10.5.5.11 255.255.255.0
MIMQO88 (outdoor areas) 10.55.12 255.255.255.0
NZA6-180 (first floor) 10.5.5.20 255.255.255.0
NZA6-80 (second floor) 10.5.5.21 255.255.255.0
NZA4-700 (oudoor areas) 10.5.5.22 255.255.255.0
PC (running EclerNet Manager) 10.5.5.100 255.255.255.0

Up to 255 devices, each with a different IP address (in the range 10.5.5.1 — 10.5.5.255),

could be part of this example network.

If you want to know your local network TCP / IP configuration, a simple method is to open
the Windows command console (Start-> Run-> CMD) and to run ipconfig /all command.

More information with the following link:

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en-

us/ipconfig.mspx?mfr=true

Despite not supporting DHCP, EclerNet devices (and generally any device with

static IP) can coexist with dynamic IP devices, as a DHCP server usually reserves
a fraction of the addressing range for dynamic allocation and another fraction for static
allocation.
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5.1.7 CONNECTING THE DEVICE

Once a device has been identified (network parameters assigned), its connection status

icon is litin red.

2’01

= Project Explorer

g "

v Project "Manual

v f’? Devices (3 groups)

v i Al
v [ B | MAIN PA

CHI1 : MAIN PA LEFT
1l CHZ : MAIN PA RIGHT
[ m ] MAIN PA
CH1 : MAIN PA LEFT
1l CHZ : MAIN PA RIGHT
[ &l | Basement AMP #1

| Basement AMP #2

S31ON 3SV3INad
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B
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| First Floor AMP #1

| First Floor AMP #2

| MAIN PA g
— zZ >
| MaIN PA 8 I

| Dutdoor Zone 1 AMP #1 LEn

| Outdoor Zone 2 AMP #2

| Outdoor Zone 3 AMP #3 o
—— - . , o
=z
z 4
cg
_‘

= Project Explorer

123rodd
IBN43193

v = Project "Manual”
v f‘? Devices a
v f Al 9 %
w [ &l | MAIN PA g >
5 Rename... m =
i|3) CH1 : MAIN F nm
Edit Comments... m
CH2 : MAIN F
- Delete delete
w [ B | MAIN PA
CH1 : MAIN F G
>m
CH2 : MAIN F Z XD
[ &l || Basement ¢ Move Down ettl + down P
R Basement <3
'y
e BTN Activate Device Finder O x
| First Floor 2 '9

— Metwork Configuration...

| First Floor

| MAIN PA Connect
| MAIN PA Detach

| Outdoor Zc

| Outdoor Zc

| Outdoor Zone 3 AM

| Safety Perimeter AMP #1
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Selecting it opens the context menu window for the synchronization mode. From this

window you must choose a synchronization mode for the device:

e send the current status of the Project virtual device to the hardware device
or

e update the virtual device status in the Project with actual status of hardware device

Once connection has been established (blinking green connection icon), the device is

removed from the “Online and Unused Device List” in Project Explorer Helper.

Once synchronized, the networked hardware device appears in EclerNet Manager with its

green connection icon lit.

(® EclerNet Manager - Manual® an
File Edit View Help

e o v [gecLer

= Project Explorer —o0uou—o-— Device Groups D
2 =

Project "Manual"

v /@ Devices
v @@ Al
v [ & ] MAINPA

]9 CH1 : NO LABEY First Floor AMPS

) CHz : NO LABERSITNT
v 3] mam pA
) CH1 : MAIN PA LEFT
) CHZ : MAIN PA RIGHT
» [ ] Basement AMP #1
» s8] Basement AMP #2
» [_&&_] First Floor AMP #1
» s8] First Floor AMP #2
» [ &8 ] MAINPA
» [ m8 ] MAIN PA
» 8] Outdoor Zone 1 AMP #1
» [_s& ] Outdoor Zone 2 AMP #2

When a device is online and connected, all remote control and monitoring operations
provided by EclerNet Manager can be performed, starting with the simplest, device
powering up:

(® EclerNet Manager - Manual® [CYo]x]
File Edit View Help

&5 e wwi  JecLer

= Project Explorer Device Groups D
| Ou =

afety Perimeter AMP #3
Second Floor AMP #1
Second Floor AMP #2
Technical Spaces AMP #1
Technical Spaces AMP #2
v [ 8] Technical Spaces AMP #3
) CH1 : Channel 1
i) CH2 : Channel 2
v f5* Basement AMPS
» [ W8 ] MAINPA
» &) MAIN PA
» f5* First Floor AMPS i [ NeA4000T

v & Channels

rreser

> @& Al - MAIN PA 01 - EMPTY PRESET + @@
P& Basement LEFT side ch
P& Basement RIGHT side ch

NO LABEL
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5.2 CUSTOMIZING AN ECLERNET PROJECT

It is advisable to perform some customization tasks on the Project in order to facilitate

understanding and subsequent handling, such as:

e Rename devices. The name given to a device when adding it to the Project may
neither be particularly handy nor descriptive. You can later rename the devices to

meet those necessities.
¢ Rename device or channel groups. Ditto as above.

e Rename device channels. All channels are displayed by default with the name
“Channel 17, “Channel 2", etc. It's really handy to choose a name referring to the

device they belong to or representing their functional role in the installation:

1) CHL : Channel £

» [ Ml | Technical Spaces AMP #2

» [ ®B | Technical Spaces AMP #3
» P5® Basement AMPS ( ; Basement

v F5* First Floor AMPS
Tl First Floor
w [ mall | First Floor AMP #1 AL

il CH2 : Showroom Right ch
» [ na ) (EIESEEE . Rename Channel
v ""-’Ei Channels
> 'FC‘ Al Channel Name Showroom Left ch
P& Basem|

f—
¢ Basemy Cancel

e Add/edit comments for devices, channel or device groups. The context menu for

these items (Edit Comments) allows associating a short text as a comment.

» “p Basement AMPS
v P5® First Floor AMPS

I = N - oc.iccs from Group:Fi

CHL1 : Showroom Left ch
CH2 : Shigl Right ct Edit Comments (%)

o Device "First Floor AMP #1"
v B Channels
>

& Al Amplifier for the stereo PA installed in the Showroom in the first

B C 2 B,
? Basement LEF| fltc.or. It feeds a couple of UMA215 speakers at the front of the
stage.

= Basement RIG|
Channel List

i|3)) First Floor AMP #1 - C|

| First Floor AMP #1 - C|

| First Floor AMP #2 - C|

Cancel

v 5™ First Floor AMPS

w [_ml | First Floor AMP #1

CBE e VRS Tl Device "First Floor AMP #1"

| CH2 : Show

Amplifier for the stereo PA installed in the Showroom in the first
SRR floor. It feeds a couple of UMAZ15 speakers at the front of the stage.
NPAAQOC
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e Define Project options such as e-mail notifications, users, passwords, etc.:

See section: Edit Menu: section “Project Users and Project Settings

Passwords are blank by default for new Projects and are not requested to

-

open them later, unless you edited them with the previous option.

e Save the Project.The File -> Save or File -> Save As menu entries allow the Project

to be saved on your local hard drive or another storage device, keeping the same

name and location (Save) or with the ability to change both (Save As).

5.3 ECLERNET PROJECT CONTROLS AND INDICATORS

5.3.1 REDUCED VIEW

The reduced view (Detail mode disabled) of a NPA, NZA, MIMO88SG, MIM0O1212SG,

MIMO4040DN, DUO-NET PLAYER, etc. device has the following appearance:

NPA4DOOT
Device 01

NZA4-400

Device 02

MIMOSZS8
Device 03

There are a number of user controls and icons or indicators to monitor the device:

NPA4ODOT
First Floor AMP #1

Device model and name

Device remote Power switch (not available for MIMOB88)

Status monitoring and alarms window. See Table of Status

Monitoring and Alarm Icons

PRESET

03 - EQ Dynamics ON

Active Preset window: indicates the Preset (*) currently
active in the device

Presets management icons (**):
e Save Device Preset (saves the current Preset)
e Copy Device Preset (copies the current Preset)
e Paste Device Preset (pastes the previously copied

Preset to another Preset)
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(*) A Preset is a snapshot of all the device settings at the time of saving: input selection,
volume, EQ DSP, compressor settings, etc. For MIMOS88, you can select which parts of the

configuration will be stored in a given Preset:

Save Preset 01

Device "Device 01"
Preset Name Emergeny presmi

Save Data wf Inputs
v'f Dutputs
¥ Martrix
Q‘ Pagers / Duckers
¥ Event/Remate Enables

V Link Groups

Cancel

Only those parts of a Preset will overwrite existing device settings when recalling this
Preset, other MIMOB88 parameters and settings won't be affected. For example, if only the
Matrix is enabled when you save a Preset, the future recall of this Preset will overwrite the
state of the M88 matrix only (crossing points between inputs and outputs, enabled or not,
and their levels), without affecting any other setting (inputs, outputs, Pagers/Duckers,

remote control enabling and link groups of the matrix, etc.).

Presets management is especially useful when a device has to behave differently at
different times and/or for different applications without manually and individually editing

its configuration.
(**) With Presets management, you can:

e Save a Preset with a specific name in the list of potential Presets of a device.
e Copy a Preset to a temporary memory

e Paste to a destination Preset the contents of another Preset previously copied in
the temporary memory, in the same or another compatible device. This is especially
useful when trying to clone Presets from one device to another or when you want
to create a Preset by modifying an already existing one.

e When performing the pasting operation, all the content is pasted except the Preset

name to be defined at the time of saving.
e Save a Preset on hard disk (right-click + Save Preset to file...)

e Load a Preset from hard disk (right-click + Load Preset from file...)
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5.3.2 DETAILED VIEW

The detailed view (Detail mode enabled) of a NPA device has the following appearance:

2’01

[ — Device : NO LABEL

NPA4000T = PRESET = F ane vi1.01r8

x —
m 4
= Lo = 5
GENERATOR + GONFIG + NETWORKING @ 2
L AL ouTPuT MODE STERED £ -13-06-00-00-23 n
PINK NDISE % T : LA s m e 2
e MANUAL z 9
.8 10.11.11.231 53
2" 2210 n Z
r— Mm" MAX
FREQUENCY L, ¢ 255.0.0.0 ATITENUATIIZIN
E G242 h. 7 min. GATEWAY ] 0,048
_‘
o =
TR e = = >
CROSSOVER & COMPRESSOR MONIT 2 7
LOW-PASS HIGH-PASS 8.%.0 PRI
X g
3 18 z
THRESHOLD = %
(SR ]
..D'!I:II. (-En
* 0k b
FREQUENCY FREQUENCY
38
5
& PARAMETRIC EQ cg
_‘

r.1|rr|' MAX M M s CONFIG

ATTACK RELEASE
GAIN Um
38 dB 3s
DELAY = VBEAK LIMITER ﬁ %
§ L % + - ~+
0 20k il MAX M N
FREQUENCY GAIN Q M MAK
0DOms = 8
2=
< 7T
a >
s 3 - m %
CROSSOVER ¢, COMPRESSOR MONIT @ o
LOW-PASS HIGH-PASS 18 . = .J.'I PRL
TYPE P ; x
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z3
0
0 e

(=
5
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For NZA series amplifiers, the aspect is slightly different:

PRESERIE | 4-70

NZAJ‘.‘].-—?O =  emeser 01 - bingo 3 =E FiRMwARE v1.02r2

+ NETWORKING
SOFT E er mac 00-1a-96-00-00-50
ON AT MANUAL
GO0, . oC TiME 6441 h. 57 m... 10.11.12.17
160 = = 10K [ 2210
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el i 255.0.0.0
192.168.0.1
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In case of a MIMOS88 d

igital matrix:

PROTO 16x16 =

MIMOS88
GENERATOR

PINK NOISE

Zk
]

FREQUEN

NPUT 3

: INPUT 4

: INPUT

: INPUT
:INPUT 7

D INPUT 8
:INPUT 9
) INPUT 10
t INPUT 11
: INPUT 12
: INPUT 13
: INPUT 14
: INPUT 15
: INPUT 16

() PARAMETRIC EQ

4
5
6
7

O oo
=

ot ot ok
(= BV, I -SSP T

mn* 20k M
FREQUENCY
1.605 Hz

T 01 - Test Preset

ouT 1

+ CONFIG

INPUT

SELECT
M 1

T PHANTOM

DELAY

. S

misi”

: QUTPUT 1

16x16
338 h. 37 min.

MODE
MOND

.

MAK

118ms 5

00G@®

Parametric EQ

b -
'y max M
GA|

-0.8 dB 1,0

MAX

wi

ik +18

THRESHOLD
50,0 dB

< -
i WA
DEFTH

e

L%
M WAK
ATTACK
10 ms

mis” MAR
RELEASE
300 ms
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(m) FIF v0.08r15

+) NETWORKING

v 00-1a-96-00-00-fd
10.11.11.100

r 2210
255.0.0.0
92.168.0.1

(O COMPRESSOR

HRESHOLD
+2,7dB

@ HARD ./
T SOFT
1:1

M MAX
ATTACK
10 ms

. “w
. .D
M MAX
RELEASE
300 ms

.

* / .I
M AR
MAKE-UP
0,0

Detailed views of different EclerNet devices are extensively documented along the

L

chapters of this user manual.

103rodd NN3INW SMOANIM
1X31NOD

S32IA3a
3791LVdWOD

0
>
Z
m
r
"
(=
(@]
3

S310N 3SV33d
B

d4vaiool
B

2’01

NOILONAOYLNI

SNNAN

ddv

IBN43193

TOYLNOD d3sn



) ecLer

Additionally, and for all EclerNet devices, by clicking on the Show / Hide Graph
icon (bottom right corner of the screen), you can display the window with

frequency response curves resulting from DSP processing for equalization and

crossovers applied to the device channels (see DSP processing section).
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@ VoLuME L IN 2:INPUT 2
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® Crosson 4
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Examples of graphical panel respectively for NZA amplifier and MIMO88 matrix v g

3G

In the graphical window for NPA and NZA series, the numbered icons located in the lower z g
. . . . . . '- n
right corner allow you to activate/deactivate the graphical display for the device channels L9
c 5

identified by the colour code of their own icons (red: Channel 1, Blue: Channel 2, etc.). 83
o
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In the case of MIMO88, you can select which input or output channels are displayed, what
colour will appear in the chart (double-click on Change Colour icon), and even have a

summary of the selected filter parameters (in the upper band of the window).

2’01

@ VoLume [] mN2:NPuUT2

S31ON 3SV3INad
L)
NOILONAOYLNI

® Crossoven _
@ M ourz:ouTtPuT2

@ Parav BG 0! i.h IN 4 : INPUT 4

Channel Colar
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Channel Colour
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NN3INW
1X31INOD

@ VoLume @[] m2:mPUT2

@ ] red

@ CRrossSOVER ;
) @ [ out2:ouTPUT2 green

@ Paraw EQ @ W ma:iNPUTA blue
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Cancel

S32IA3a
3791LVdWOD

The graph displays the frequency response using a frequency X axis (logarithmic, in Hz)
between 10 and 20,000 Hz, and a gain Y axis (in dB) between +12 dB and -30 dB, or
between +12 dB and -72 dB (depending on the status of the Vertical Range button,

located in the lower left corner of the graph).
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5.3.2.1 VERTICAL RANGE

This control, located in the lower left corner of the graph, allows you to
choose between two different ranges of values for the graph Y-axis (gain in
dB).

When the button has a pointing down triangle shape, the gain range is between +12 dB
and -30 dB. When the button has a pointing up triangle shape, the gain range is between
+12 dBand -72 dB.

The curve can be displayed as solid (filled) or as contour line only (outlined), depending on
the SOLID button status.

Only one of the available channels is selected as active. The active channel is displayed
with greater intensity than the rest, which appears semi-transparent. Channel selection is

done by clicking with the mouse on the desired device channel’s panel.

If the MUTE function of any channel is activated, this channel graph is represented as a

horizontal line at the bottom of the chart.

Only one of the filters in the active channel is considered as the active filter in the graph.
This filter individual response is represented with a white line. The filters selection is done
by clicking on the panel where the targeted filter controls are displayed. For parametric
equalization, individual selection of each of the filters is done through numerical identifiers

in the control panel (from 1 to 8).

The active channel filters whose type is not Bypass are represented in the graph as circular
markers. The low-pass crossover is labelled "L", the high pass crossover is labelled "H",

and parametric filters have a numerical identifier, from 1 to 8.

The graph allows interactive editing of the filter's parameters using their markers. To do
this, you just have to point the mouse on the filter marker you want to edit, to click on it and

drag it on the surface of the chart while holding the button pressed.

The active filter marker is displayed with greater intensity than the others (which appear
semi-transparent) and shows an animation with arrows indicating the available moving
directions; crossovers, for example, can only be moved horizontally (Frequency parameter),
while High-Shelf, Low Shelf filters and Parametric EQ can move horizontally (Frequency

parameter) and vertically (Gain parameter).

For filters with a Q parameter (Parametric EQ, All-Pass order 2), Q value may also be edited

through graphic markers using the mouse wheel.
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5.3.2.2 FILLED CURVES (SOLID)

This other control, located in the lower right corner of the graph, allows JFEiLIDf (EuNl

you to select the option to fill the chart or not.

A black SOLID word over a white rectangle means the graphic curve is filled. A white SOLID

2’01

word over a black rectangle means the graphic curve is only outlined.

5.3.3 TYPES OF CONTROL

S31ON 3SV3INad
L)
NOILONAOYLNI

The detailed view of an EclerNet device contains various types of user controls, which allow

you to adjust parameters for DSP processing. The main types of controls are:
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5.3.3.1 ADJUSTMENT POTENTIOMETERS

To rotate a potentiometer, place the mouse cursor over it, left click, hold the mouse button,

and drag up (or right) to rotate clockwise or down (or left) to rotate counterclockwise.

M MK +

M MAX »
GAIN M MAK

You can also change a potentiometer value by hovering over with the mouse, pressing the
left mouse button, and turning the mouse wheel.

Double-clicking a potentiometer will reset it to the default position (depending on the
parameter).

5.3.3.2 CHANNEL FADER

The fader is a graphic sliding control. To move the fader, point the mouse cursor

on it, left click, hold the mouse button, and drag up or down.

You can also change a fader value by hovering over with the mouse, pressing the
left mouse button, and turning the mouse wheel.

Double-clicking it will restore the default position (0 dB).

5.3.3.3 BUTTONS

. . =l
All buttons operate the same way: to activate a button, you should point o
the mouse cursor on it, press and release the mouse left button. L

5334 SELECTORS Bypass

+ Bypass

Parametric EQ
Some parameters must be chosen with selectors from a list of available Low-Shelf 6dB/act
Low-Shelf 12dB/oct
values. These controls are identified by their double arrow pointing up High-Shelf 6dB/oct
L. . High-Shelf 12dB/oct
and down on their right side. Low-Pass 6dB/oct
Low-Pass 12dB/oct
. . . . High-Pass 6dB/oct
To select a new value in the list, click the control with the mouse and a High-Pass 12dB/oct
All-Pass order 1

list of all available values will appear. Select the new value with the All-Pass order 2
mouse by left click on it. The list will be closed, and the new element will

appear selected in the control.
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5.3.3.5 NUMERICAL VALUES

Some of the above controls have an associated display showing the numerical value. These

displays can also be used to edit the parameter value.

To edit a numerical value, you just must place the mouse cursor over it and left click.
Automatically, the control enters edit mode allowing typing the desired value (only

numbers without units).

Pressing the ENTER key will update the associated control value. Pressing the ESC key will

cancel the editing and keep the previous value.

Double-clicking some controls will reset them to their default position.

5.3.4 TABLE OF STATUS MONITORING AND ALARM ICONS

Icons indicating the status of any system function, or any alarm triggering appear in

different windows:

- Device disconnected.

e Steady red: the device has been manually disconnected (with Disconnect

option).
e Blinking red: EclerNet Manager tried to connect to the device, but this one

is not available.

E Device connected:

Blinking green.

The device is correctly connected to EclerNet Manager

ﬂ Device connected and synching.

The device is establishing the connection to EclerNet Manager

Device connected with warning.

The device is connected, but there is a problem.
If the icon is displayed in a device status area, then another icon indicates the

kind of problem (invalid EclerNet protocol version, unsynched, etc.).

If the icon is displayed in a channel status area, it's indicating a problem with the
device (it is recommended to consult the device status area for more

information).

u Invalid EclerNet protocol version.

The current version of EclerNet Manager does not allow its connection to
networked devices (Version mismatch between software and firmware).

Therefore, no connection can be established, but it is possible to upgrade the

firmware from Project Explorer Helper.
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Invalid password.

The password entered in the device is incorrect.

Device unsynched.
The two icons are alternatively displayed.

Hardware content (state, presets ..) does not match the device content in
EclerNet Manager.

Device powered.

The device is switched on (POWER ON).

Channel protect alarm.

The electronic protection alarm is activated for the channel. It lights up for a few

seconds during the boot sequence and it's normal.

Channel thermal alarm.

The thermal protection alarm is activated for the channel.

Channel load alarm.

The impedance load protection alarm is activated for the channel.

B OO 0 8 B B

Device mains voltage alarm.

The AC power voltage alarm is activated for the device.

Device system error.

Device error alarm (some component inside the device is malfunctioning)

=

h

Device system fault.

Device malfunction alarm (blown fuse, protection system permanently
triggered, etc.).

This alarm appears along with a fault window in the device LCD.

Slave link fault.

MASTER-SLAVE connection between two MIMO88s is not valid (physical link
between the LINK BUS connector on the back panel of both MIMOB88 units and
crossover CAT5 cable). Possible Causes:

e Connection is lacking or is defective

e The rear panel switch of the SLAVE unit is not on SLAVE position

Invalid Slave version.

Software - firmware version mismatch in the SLAVE unit of a pair of MIMO88s..
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Channels group set in SOLO mode

Can Bus DC Power Fail (MIMO units)

2’01

NXA units self-test has reported one or more channels having issues

3 HDO

S31ON 3SV3INad
L)
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I Some of these icons are device dependent, being only available for some series

and/or models.
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COMPATIBLE DEVICES

Amplifiers / Digital Audio Managers:

o NPA Series

=
o NZA Series g
o NXA Series —

Digital Matrixes:
o MIMO88
o MIMO88 CONFERENCE
o MIMO88SG & MIMO1212SG
o MIMO4040CDN /MIMQO7272DN - Dante™ Matrixes
o MIMO40C40DN - Dante™ Matrix for Conference with AEC

S31O0N 3SVv3ITad
L)
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dvaiool
B
SNN3INW

Audio Players:
o DUO-Net Player

SMOANIM
ddv

e Dante™ Protocol Compatible Devices:

o DN44BOB

NN3IN
1X31INOD

e Video Over Ip Extenders and Matrixes:

o VEO-XTI2L and VEO-XRIZ2L

123roydd
19N4223

¢ Digital Controls & Panels:
o WPNETTOUCH
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3781LVdN0OD
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6.1 AMPLIFIERS / DIGITAL AUDIO MANAGERS

6.1.1 NPA AND NZA AMPLIFIERS SERIES

6.1.1.1.1 NPA SERIES DETAILED VIEW

2’01

The top section of the detailed window provides the following items:

== Device:First Floor AMP #1

N PA4000T 0 = 03 - EQ Dynamics ON y mimE v1.00r7

GENERATOR [+ CONFIG + NETWORKING AES/EBU

STERED 00-13-96-00-00-11
PINKNOISE + OFF J-1a-96-00

S31ON 3SV3INad
L)
NOILONAOYLNI

MANUAL

25::; 10.0.100.9 . l‘ "

232 3 2210 1€ 5
2 AV 2 MIMT AN
0 e00.0 ATTENUATION
742 h. 18 min. 10.0.0.2 0,048

dvaiool
B
SNNAN

== Device: First Floor

NPA4000T

SMOANIM
ddv

Device model and name

NN3INW
1X31INOD

Device power switch

Status monitoring and alarms window.

123rodd
IBN43193

See Table of Status Monitoring and Alarm Icons

Active Preset window: indicates the Preset currently
03 - EQ Dynamics ON = o . . )
active in the device (See section: Reduced view)

S32IA3a
3791LVdWOD

Presets management icons:

e Save Device Preset (saves the current Preset)

o Copy Device Preset (copies the current Preset)
==
e Paste Device Preset (pastes the previously

(don) s1aNvd
T0Y1INOD ¥3SN

copied Preset)

(See section: Reduced view)

viDn7 Unit’s firmware version
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GENERATOR

SINEWAVE =
7k

Internal signal generator offering pink noise, white

[“:"'"f\ 3K noise, sine wave and polarity check, with frequency
10 = =10k

as e adjustable between 10 and 20,000 Hz

FREQUENCY
1.000 Hz

2’01

+ CONFIG

E STERED

Device configuration. See (1)

S31ON 3SV3INad
L)
NOILONAOYLNI

2323V
0
ME T42 h. 18 min.
3 =z
by © 5 3
c 00-1a-96-00-D00-11 i-; %
MANUAL ?
10.0.100.9 Network parameters configuration. See (2) e
210 s
255.0.0.0 z 5
10.0.0.2 33
s
wn
8
Digital AES/EBU input: a VALID message is displayed = z
Zz
when a valid AES/EBU signal is input in the device. < g

METCMAR Provides a £12 dB trim adjustment
ATTENUATHON

0, B
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#4223

S32IA3a
3791LVdWOD

(don) s1aNvd
T0Y1INOD ¥3SN




) ecLer

(1) Device configuration. + CONFIG

Change Device Configuration

Clicking on the configuration edit icon opens the

parameter setting window:

Device Configuration

2’01

Device "First Floor AMP #1"

Output Mode STEREOQ

Volume Link 'OFF

S31ON 3SV3INad
L)
NOILONAOYLNI

Anticlip Mode SOFT

Maximum Mains Voltage

Enable Mains Voltage Alarm

dvaiool
B
SNNAN

Cancel

g
Z >
O3

o]
?n o

For an NPA Series amplifier, adjustable parameters are:

(@]
e Output Mode: STEREO/BRIDGE/PARALLEL. S %

Z
Selects the operating mode of the device amplified outputs: stereo, bridged or < ?.

parallel (see the hardware NPA Series owner’s manual).

e Volume Link: ON/OFF.

123rodd
IBN43193

Determines if both channels’ volume controls of an amplifier are linked (ON) or
independent (OFF).

e Anticlip Mode: SOFT/MID/HARD. E %
The protection system against saturation can operate in SOFT, MID, or HARD mode. a %

e Maximum Mains Voltage: 200 to 280 V AC (version for 230 V AC nominal voltage.) m
Determines the AC mains voltage threshold above which overvoltage occurs. c

e Enable Mains Voltage Alarm: Determines whether threshold exceeding should % %
trigger or not a system alarm. % %
30
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The window hereunder shows the adjustments made, the real time reading of the voltage
(NOW), the number of times it exceeded the threshold (COUNT) and the cumulative

operating time of the device (OPERATING TIME):

+ CONFIG

(2) Network parameters configuration.

STERED

OFF

SOFT

266V

2323V

1]

742 h. 18 min.

Exactly the same window and same parameters than those available with Network

Configuration in the device context menu:

Network Configuration

Device "First Floor AMP #1"

Ethernet MAC
IP Address

IP Subnet Mask
IP Gateway

UDP Port

00-1a-96-00-00-11

10.0.100.9

255.0.0.0

10.0.0.2

2210

Cancel

See section Creating an EclerNet Project for more details.

The lower right section of the device channel window presents the following appearance

for NPA Series:

MONITOR

PROTECT

+ CONFIG
GAIN
26 dB
¢ LIMITER
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PFROTECT
COWRT o

Counter for the number of times the device protection alarm has been
triggered

TEMPERATURE

Heat sink internal temperature meter (in % of alarm triggering threshold)

Counter for the number of times the device temperature alarm has been
triggered

Load impedance at the device terminals (1)

Counter for the number of times the device load impedance alarm has
been triggered

RMS power meter at the channel output terminals

Peak power meter at the channel output terminals

+) GONFIG
GAIN
26 dB
WPEAK LIMITER
MAX OFF
LOAD ERROR
MR 0,5
MAX 50

RMS voltage meter at the channel output terminals

Peak voltage meter at the channel output terminals

Channel configuration. See (2)

(1) The real time measurement of load impedance and the activation of the relevant alarm

are affected by the functional state of hardware and the installation cabling load (in case of

crossing or open circuit in a speaker line, faulty amplifier, etc.), as well as by some audio

program and volume transients produced over the time.

This may generate occasional measurement inaccuracies, leading to a false alarm

triggering:

I Itis important to note that the load impedance alarm triggering can be due to a

combination of temporary factors which are not abnormal in the installation. Check after

triggering if the triggering condition is maintained over time, i.e., whether it is a false alarm

or a true one requiring maintenance.
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(2) Channel configuration.

PEAK 0,6
Clicking on the configuration edit icon

KN MAK MM MAK e EUNF'G

ATTACK RELEASE
GAIM

e 45

opens the parameter setting window:

For an NPA Series amplifier, e Channel Configuration

adjustable parameters are: Channel "Showroom Left ch"

Gain 26 dB —

e Amplifier total Gain: 26 /32 /
38 dB

Vpeak Limiter Threshold
Minimum Load

e Vpeak Limiter Threshold: Maximum Load

Enable Load Alarm

maximum peak output
voltage to  which the

Cancel

equipment limiter reacts.
o 40to 119 V/OFF for NPA4000T
o 40 to 99 V/OFF for NPA2500T

e Maximum Load/Minimum Load: between 0.2 and 100 ohms. Load measurement
range outside which the load impedance alarm (LOAD) is triggered and counted
(COUNT).

e Enable Load Alarm: enables/disables the triggering of the load impedance alarm.

Additionally, there are two icons named “Copy Channel
Data” and “Paste Channel Data” in the control window of

each device channel (upper right part).

=)
Clicking on “Copy Channel Data” in a channel (source DUT LE‘h‘IEL

channel) stores all parameters in a temporary memory.

Clicking on “Paste Channel Data” in a channel, copies in the destination channel the
parameters stored temporarily during the last “Copy Channel Data” operation, configuring

the destination channel like the source channel.

2’01
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6.1.1.1.2 NZA SERIES DETAILED VIEW

: Device: Device 01

NZAG6-70

Device model and name

Device power switch

Status monitoring and alarms window. See Table of

status monitoring and alarm icons

03 - EQ Dynamics ON =

Active Preset window: indicates the Preset currently
active in the device (See section: Reduced view)

Presets management icons:

o Save Device Preset (saves the current Preset)
e Copy Device Preset (copies the current Preset)
o Paste Device Preset (pastes the previously

copied Preset)

(See section: Reduced view)

v1.00r7

Unit’s firmware version

GENERATOR
SINEWAVE
200

- iy
FREQUENCY
1.000 Hz

Internal signal generator offering pink noise, white
noise, sine wave and polarity check, with frequency
adjustable between 10 and 20,000 Hz

Device configuration. See (1)

+/NETWORKING

C 00-12-86-00-00-11

Network parameters configuration. See (2)

2’01
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NZA6-70 ©@ PRESET 01 - Empty

GENERATOR  (# CONFIG +/ NETWO

SINEWAVE %
s 0.0.0.0
2210

20" =
FREQUENCY k 0.0.0.0
1.000 Hz GaTeway 0.0.0.0

(1) Device configuration.

Clicking on the configuration edit icon opens the parameter setting window:

NZA Device Configuration
+CONFIG

Device "Device 01"

Anticlip Mode SOFT

Change Device Configuration

Auto-5tandby Mode ON

Cancel

For NZA series amplifiers, adjustable parameters are:

e Anticlip Mode: SOFT/MID/HARD.
The protection system against saturation can operate in Soft, Mid or Hard mode.

e Auto-Standby Mode: ON/OFF. Enables/disables the automatic sleep mode (low

consumption) when no input signal is detected in any channel of the amplifier.

The next window shows the status of the adjustments made,

+ CONFIG

as well as the number of accumulated operating hours of the
device (OPERATING TIME):

(2) Network parameters configuration. Network Configuration

. Device "First Floor AMP #1"

Exactly the same window and same parameters than
. . . . . Ethernet MAC 00-1a-96-00-00-11

those available with the Network Configuration option
. IP Address 10.0.100.9

from the device context menu:
IP Subnet Mask 255.0.0.0

See section: Creating an EclerNet Project IP Gateway |10.0.0.2

UDP Port 2210

Cancel
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The lower right section of the device channel window presents the following appearance

for NZA Series:

) ecLer

OUT LEVEL

ENAELED
-

LEVEL

REMOTE

B L

+ GONFIG
GAIN
26 dB
OUTPUT MODE
SINGLE

COMP. MODE
COMPRESSOR

EMAEBLED
L1

Presence signal indicator (green) at the channel input

LEVEL

Reading of the channel’s volume control position on the hardware front
panel. The position of this hardware control is a part of amplifier
hardware and is not remotely adjustable from EclerNet Manager
application. It determines the maximum signal level coming out from
this amplifier channel output (O dB means no attenuation or, which is
equivalent, maximum volume).

REMOTE

B ¥

VCA port selector for remote control of channel volume, with a total of
4 or 6 ports, depending on the NZA amplifier model. Connecting for
example a potentiometer to the VCA port of a channel of the amplifier
allows you to remote control its volume.

The maximum volume of a channel, whether it is assigned to a VCA
port or not, will always be determined by the position of its hardware
volume control.

A same VCA port can be assigned to several amplifier channels
= for a simultaneous remote control of all assigned channels.

REMOTE

Metering of the control voltage detected at the selected VCA port (port
B in the example). The metering is proportional to the volume control
applied to the channel: 0dB indicates maximum volume (zero
attenuation due to VCA remote control).

+) GONFIG

GAIN
26 dB
OUTPUT MODE
SINGLE

COMP. MODE
COMPRESSOR

Channel configuration. See (1)
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(1) Channel configuration.

Clicking on the configuration edit icon opens the

Change Channel Configuration

parameter setting window: wor. e’ cw T AVONFIG

2’01

Bypass NZA Channel Configuration
Channel "NO LABEL"

Gain 26 dB

S31ON 3SV3INad
L)
NOILONAOYLNI

Output Mode SINGLE

Compressor Mode COMPRESSOR

dvaiool
B
SNNAN

Cancel

SMOANIM
ddv

For NZA series amplifiers, adjustable parameters are:

e Amplifier total Gain: 26 /32 dB
e Output Mode: SINGLE / BRIDGE / PARALLEL

NN3INW
1X31INOD

o In SINGLE mode, a channel is absolutely independent of the other amplifier

channels for all settings (input selection, volume, EQ, compressor settings,

123rodd
IBN43193

etc.). In this mode, each channel has its own control window in EclerNet

Manager.
o In BRIDGE and PARALLEL modes, channels are linked, set and controlled 5 3
by pair, appearing in software as a unique control panel for each pair of 2 §
linked channels. Possible pairs are always made of consecutive channels: ﬁ 'E‘_J
1&2, 3&4, 5&6 (depending on NZA device, whether 4 or 6 channels). "
e Compressor Mode: COMPRESSOR /VPEAK LIMITER (voltage peak limiter). 2 <
It determines how the GUI of the channel compressor will look, with a choice é g
between the aspect of a classic compressor and a voltage peak limiter for the output c3
signal of the amplifier (see COMPRESSOR section). 8 ,8




6.1.1.1.3 INPUT

The input section contains the following controls:
IN 1

e SELECT: allows you to select this channel input amongst N 2
DIG IN1

DIG IN2

available sound sources:

201

w GEN
GEN =

o [IN1/IN2, etc.: amplifier's analogue input 1, 2, etc.
(and also IN1+2, IN3+4, etc., for NZA series)

o DIG IN1/ DIG IN2: amplifier's digital input 1 or 2
(available in NPA series)

S31ON 3SV3INad
L)
NOILONAOYLNI

o GEN: internal generator signal, controlled from the
GENERATOR panel.

e LINK: links channels for simultaneous operation (available
in NPA series)

dvaiool
B
SNNAN

o VOLUME: channel volume, adjustable between —infinity

and 0dB. There are two Vu meter-type level indicators to the right of the channel

fader: the left bar displays the input signal level and the right one the channel output % >
signal level after processing. % A
e SOLO: mutes all device channels except those with SOLO function enabled.
e MUTE: mutes this channel audio signal. E %
¢ INVERT: allows the input signal phase to be inverted (180 degrees shift). < S

6.1.1.1.4 CROSSOVER

123rodd
SEINIETRE |

The CROSSOVER section contains the FILTER TYPE B

— —~a_ cc o)

and FREQUENCY parameters for each of the two sow _:“55 HIGHTPASS = e

filters (low-pass and high-pass) composing the [ + Drpes é g

crossover. It splits the audio frequency spectrum in 1"\ "'f'_:m Y o8
two parts, creating the two bands usually used in 2tk 0
FR E'_}__IJEN Y FREQUENCY

two-way speakers. 1l G

>m

% po)

o FILTER TYPE: allows you to select the crossover filter type. You can select one of o §

the following filter types. § é‘

i

o Butterworth 6, 12, 18 or 24 dB/oct
o Bessel 12, 18 or 24 dB/oct
o Linkwitz-Riley 12 or 24 dB/oct

e FREQUENCY: is made of a potentiometer and a numerical value to adjust the filter

cut-off frequency within the 20 Hz - 20 kHz range.
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6.1.1.1.5 PARAMETRIC EQ

This section groups the eight parametric (0) PARAMETRIC EQ

filters available per channel, very useful
for a precise correction of the frequency

response.

Available parameters are described below
(the parameters are always displayed for
one of the 8 filters, the one with its

0] 2]

7% TYPE Parametric EQ
600, - * - Sk

) s
" 2k M MAX M
FREQUENCY GAIN

106 Hz +3.5dB 12,0

15I:I*I — 1"1I:IF:

numeric indicator filled in white, as filter #2 in the image):

e ON/OFF: turns on/off the parametric EQ, affecting all filters from this section. When
the value is OFF (top left button greyed out), there is no filter processing (all filters

are bypassed). In the opposite case (green button), operation is determined by the

other parameters.

e FILTER TYPE: type of filter used. You can select one of the following filter types

(adjustable controls for each filter type are shown between brackets):

O

O

Bypass: filter not used.

Parametric EQ (FREQUENCY, GAIN, Q): classic parametric equalizer filter
with adjustable central frequency (between 20 Hz and 20 kHz), gain or
attenuation at central frequency (between +12 dB and -60dB) and
bandwidth (1/Q, Q between 0.3 and 200).

Low-Shelf and High-Shelf with a 6 or 12 dB/oct slope (FREQUENCY, GAIN):
shelving type filters with adjustable cut-off frequency (between 20 Hz and
20 kHz) and gain or attenuation (between +12 dB and -60 dB).

Low-Pass and High-Pass with a 6 or 12 dB/oct slope (FREQUENCY):
these are low-pass and high-pass filters with adjustable cut-off frequency
(between 20 Hz and 20 kHz).

All-Pass order 1 and 2 (FREQUENCY, Q in order 2): all-pass filters that do
not affect the signal amplitude, but the phase at certain frequencies (in
contrast with delay, which changes phase at all frequencies). This type of
filter is mainly used to compensate for phase errors in speakers or other
causes, such as phase shifts introduced by the crossover.
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6.1.1.1.6 COMPRESSOR

The compressor section offers a processing of the input signal
dynamic behaviour, allowing the output intensity to be controlled not

to exceed certain levels. Available settings are: 36° +18
THRESHOLD

3,308
e ON/OFF: turns the compressor on/off (green button/grey

button). When in OFF mode, the rest of the section controls

are disabled.

e THRESHOLD: compression threshold. Composed of a

potentiometer and a numerical value, and used to specify the

. . . . . . T MAK Ml MAR
input signal level at which compression begins to occur. This ATTACK RELEASE

parameter ranges from +18 dB to -36 dB.

e RATIO: compression ratio. It also includes a potentiometer and its associated
numerical value. This parameter determines the output volume reduction ratio
when the input signal level rises above the threshold. A value of 1:1 states that the
signal level does not undergo changes, while the extreme value of inf:1 represents
a signal limiter, with which any signal above the threshold will be limited to that
threshold level.

e ATTACK (potentiometer and numerical value): attack time. Determines the time the
compressor takes to respond when the input level rises above the threshold. The

range extends from 0.1 ms to 500 ms.

e RELEASE (potentiometer and numerical value): determines how quickly the
compressor stops operating once the signal input level drops below the threshold.

In this case, the range covers from 1 msto 5 s.

Setting the compressors’ ATTACK and RELEASE times correctly is not an easy task: too
short release or attack times result in excessive and perceptible low frequencies distortion;
on the other hand, too long times could make a limiter useless if damages already occurred

before limitation starts.

In order to help you to correctly set these values, the AUTO parameter automatically select
ATTACK and RELEASE values, using the crossover high-pass filter cut-off frequency as

internal reference.

When AUTO is enabled, ATTACK and RELEASE controls editing is disabled, but used
values are still displayed. (© VPeak LIMITER

Additionally, some devices (NZA series) can display the compressor

mn® MAX
THRESHOLD

function in voltage peak limiter mode, changing the GUI appearance, as |E-G__—=tl
shown in the attached image. &

In this mode, the limiting threshold appears in volt units and RATIO,
ATTACK and RELEASE controls are disabled.

M max M MAX
ATTACK RELEASE
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6.1.1.1.7 DELAY

The DELAY section allows you to set an independent delay time

DELAY .
LN

for each channel, which is applied between input and output.

The delay time can be specified in different units, selected with Mm MAX
167 ms —

UNITS parameter. Available units are milliseconds, seconds,

centimetres and meters. DELAY can be set between 0 and 1000 milliseconds.

To avoid weird and annoying noises in the output signal, the value change made with the
DELAY potentiometer is not effective until the mouse button is released. At that time audio
will be temporarily muted (for a variable time, depending on the delay value used) for the
new setting to be effective

6.1.1.1.8 COPYING AND PASTING SETTINGS BETWEEN CHANNELS

e}

Copy Channel Data and Paste Channel Data icons (), located in the upper right
corner of the control panel of each device channel, are used to copy all settings from one
amplification channel in a temporary memory and paste them in another amplification

channel.

¢ Channel copying and pasting can be done within a single device or from a device\

L

channel to a channel of another device.

e |n the latter case, copying and pasting operation can only be made between
channels of the same device series (you cannot copy a channel from an NPA
amplifier and paste it into a NZA amplifier, or vice versa).

e To clone the full configuration of all channels from one device to another, use

Copy Device Preset and Paste Device Preset from the icons to the right of the

preset name in the upper section of the device configuration.
- )

2’01
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6.1.2 NXA SERIES, SELF-POWERED DIGITAL AUDIO MANAGER

6.1.2.1 INTRODUCTION TO NXA SERIES

NXA is a series of "all-in-one" digital audio devices: a multichannel self-powered digital
manager, an evolution of the EclerNet NZA series of amplifiers integrating a digital audio
matrix. In some projects, a digital amplifier with Ethernet/RS-232 remote control is
essential, yet insufficient to meet all requirements, as input signal mixing, source selection,
priorities, self-diagnostics for the correct operation of the device, user control interface, etc.
Adding a digital matrix to the equipment list may exceed the budget. This is where the NXA
series fits perfectly: an amplifier/processor hybrid digital device, a complete audio solution
that provides multiple methods of remote control with a long list of features.

NXA device programming is performed with the EclerNet Manager application, either via a
CATD5 point-to-point connection (directly from the computer to the NXA device) or from a

remote point of the Ethernet network it is linked to.

The remote management for NXA and in general for any EclerNet compatible device (as
NZA or NPA amplifiers, or MIMO88 matrix) can be done in the following ways:

e with the EclerNet Manager application, either via a CAT5 point-to-point connection
(directly from the computer to the NXA) or from a point of the Ethernet network it

is linked to

e from EclerNet clients of Ethernet Manager, or UCPs (User Control Panels): several
simultaneous web clients, each with its own custom control panel, and EclerNet
Manager acting as a web server. EclerNet Manager allows to create such control

panels in a very simple and intuitive manner

o from external “third-party” control devices (Crestron®, AMX®, Extron®, VITY®,
Medialon®, RTI®, etc.), using for this the TP-NET Ecler communication protocol
integrated in the NXA series and the Ethernet or RS-232 communication of the

device

The NXA has 4 or 6 analogue audio inputs and 4 or 6 amplified outputs (4 or 6 channels,
depending on model), from 80W per channel up to 400W per channel (depending on
model). All inputs are balanced, at a nominal line level, while the amplified outputs can be
set to work in SINGLE, PARALLEL or BRIDGE mode.
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With EclerNet Manager you can configure the NXA for all types of audio processing tasks

(DSP or Digital Signal Processing) on incoming signals, such as:

¢ Independent audio input mixer for each channel of the device (mixing matrix),
allowing to generate a different mixing than the ones made in the other channels

¢ Independent controls per channel: VOLUME, MUTE, SOLO, PHASE INVERSION,
MAX. VOL (upper volume limit) and MIN. VOL (lower volume limit)

e LP and HP crossover filters, up to 4th order, per channel

e Bank of 8 parametric EQ filters, per channel

e Compressor with THRESHOLD, COMP. RATIO, ATTACK, RELEASE, and MAKE-
UP KNEE GAIN settings, per channel

e Delay, up to 1000 milliseconds, per channel

e DUCKER function (priority): an input can be configured with highest priority, being
able to reduce and replace the audio content of any channel, when its signal
exceeds the detection threshold. This feature is vital in emergency/evacuation
systems, which should play a specific alarm and/or evacuation message instead of
the regular audio program when an emergency scenario is detected

e 5 configuration memories (presets) are available

As inputs for hardware control devices, the NXA has 4 or 6 GPI ports (depending on model),
or General-Purpose Inputs, 0-10 VDC. These control inputs can be connected to external

devices such as contact closures, potentiometers, Ecler WPm / WPa series panels, 0-10

VDC voltage sources, etc.

The GPI inputs can be programmed to control certain functions of the NXA device from

external hardware devices:

e recall one of the 5 available Presets (through a WPmMVOL-SR, WPaVOL-SR or
WPTOUCH wall panel)

e select a sound source in a preset list of the unit audio inputs for one channel or
multiple channels simultaneously (through a WPmMVOL-SR or WPTOUCH wall
panel)

e adjust the audio volume of one or more inputs, or one or more outputs (through a
WPmMVOL, WPaVOL, WPMVOL-SR, WPaVOL-SR or WPTOUCH wall panel)
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Other remarkable features of the NXA series are:

e TP-NET external remote-control protocol, via Ethernet and RS-232 (compatible
with Crestron®, AMX®, RTI®, VITY®, etc.)

e POWER ON/OFF button and/or front panel volume controls deactivated by

software, preventing unauthorized tampering

e Front panel volume controls can be assigned to one or more audio inputs or one or

more amplified outputs

e Self-diagnostics function for the correct operation of the amplifier, with FAULT
relay: allows the device failure detector to switch to an external redundant system,

replacing the faulty unit with a spare one
e Integrated "Anti-clip" system

For more information about NXA Serie's hardware, refer to the product manual.

6.1.2.2 GENERAL SECTIONS OF THE DEVICE

The top section of the detailed window provides the following items:

NXAG "'80 E‘] - FRESET 01 - EMPTY PRESET ¥ Him IRMwWARE v1.02r9

GENERATOR  (+ CONFIG + NETWORKING

SIGNAL
SINEWAVE El

ANTICLIP MODE SOFT AMP TEST MODE (OFF ETHERNET MAC  00-1a-96-00-e6-97
AUTO STANDEY OFF POWER BUTTON ENABLED ADDRESSING MODE MAMNUAL
PRESET 1 START UF OFF LEVEL KNOBS ENABLED IP ADDRESS 10.11.11.156
a L uDP PORT 2210
?ZRIEQU[N z_l“l‘ SUBNET MAsK 255.0.0.0
1.000 Hz OPERATING TIME 116 h. 43 min. GATEWAY 192.168.0.1

Device model and name

Device power switch

Status monitoring and alarms window. See Table of
status monitoring and alarm icons

Active Preset window: indicates the Preset currently

PRESET 03 - EQ Dynamics OMN
active in the device

Presets management icons:

e Save Device Preset: saves the current Preset in
memory (click on the mouse left button) or in a
folder on your PC (click on the mouse right
button)

e Copy Device Preset: copies the current Preset

e Paste Device Preset. pastes the previously
copied Preset

2’01
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vi.02rg Unit’s firmware version

BENERATE Internal signal generator providing pink noise, white

SIGNAL

PINK

2’01

noise, sine wave and polarity check, with frequency
adjustable between 10 and 20,000Hz

0* 2
FREQUENCY

+, CONFIG
ANTICLIP MODE  SOFT AMP TEST MODE 1 MINUTE
AUTO STANDEY ON POWER BUTTON ENABLED
PRESET 1 START UF ON LEVEL KNOBS ENABLED

S31ON 3SV3INad
L)
NOILONAOYLNI

Device configuration. See (1)

OPERATING TIME 122 h. 23 min.

+NETWORKING
ETHERNET MAC (0-1a-96-00-e6-97
ADDRESSING MODE  MANUAL
IP ADDRESS 10.11.11.156

dvaiool
B
SNNAN

Network parameters configuration. See (2)

UDFP PORT 2210
SUBMET MASK
GATEWAY

SMOANIM
ddv

(1) Device configuration

NN3INW
1X31INOD

Clicking on the configuration edit icon opens the RFESIERNIIE

parameter setting window: Change Device Configuration

123rodd
IBN43193

The adjustable parameters are:

e Anticlip Mode: SOFT/MID/HARD. + CONFIG o S
The protection system against saturation NXA Device Configuration é g
can operate in SOFT, MID, or HARD mode. Device "NO LABEL" ? ﬁ

e Amp Test Mode: OFF / 1 MINUTE / 1 Anticlip Mode "SOFT
HOUR . Amp Test Mode |1 MINUTE g %
Defines the frequency of the unit self- Auto-Standby ¥ §§
diagnostic test, which confirms its correct Preset 1 Start Up § é‘
operation, checking the amplified audio FEEEETTINTY Ty e "
signal presence at its outputs; if no signal E Enable Level Knobs W/

is detected, the rear panel FAULT relay is
switched on

e Auto-Standby: ON/OFF.

Enables / disables the automatic sleep mode (low-consumption) when no input

signal is detected on any of the amplifier channels.
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Preset 1 Start Up: ON/OFF

Allows to automatically retrieve the preset number 1 stored in the unit memory
each time the equipment is initialized (the power supply is switched off and on
again). This ensures the same starting conditions for your setup each time the
device is turned on (at the beginning of the day, etc.)

Enable Power Button: ON/OFF

Allows to enable or disable the front panel POWER switch, so in the latter case the
device is protected against accidental on/off switching or unauthorized use of the
unit

Enable Level Knobs: ON/OFF

Allows to enable or disable the front panel LEVEL rotary knobs, so in the latter case
the device is protected against accidental or unauthorized adjustment of the unit's
inputs and outputs

The next window shows the status of the adjustments made, as well as the number of
accumulated operating hours of the device (OPERATING TIME):

+ CONFIG

ANTICLIF MODE SOFT AMF TEST MODE 1 MINUTE
AUTO STANDEY 0N POWER BUTTON ENABLED
PRESET 1 START UF 0N LEVEL KNOBS EMABLED

OPERATING TIME 122 h. 23 min.

(2) Network parameters configuration

Exactly the same window and same parameters than those available with Network

Configuration in a device context menu:

Network Configuration

Device "First Floor AMP #1"
Ethernet MAC 00-1a-96-00-00-11
IF Address 10.0.100.9

IP Subnet Mask 255.0.0.0

IP Gateway 10.0.0.2

UDP Port 2210
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Below this, we can find 3 tabs for the detailed configuration of:

e Front panel KNOBS and rear panel GPIs
¢ VIRTUAL buttons and volume controls from UCP panels
e DUCKER (priority triggered by audio signal level) section

0" 20k SUBNET MASK - - -

FREQUENCY GATEWAY - - -
1.000 Hz OPERATING TIME - - -

KNOBS/GPIS

Section KNOBS/GPIs allows configuring the function to be performed by the LEVEL rotary

knobs on the front panel, as well as the function of the rear panel GPI ports:

FRONT PANEL KNOBS

KNOE1 INPUT VOL. PRESETS

KNOBZ 2 INPUT VOL. INPUT VOL.

KNOE3 INPUT VOL. SOURCE SEL.
KNOE4 OUTPUT VOL. OUTPUT VOL.
KNOES OUTPUT VOL. OUTPUT VOL.

LIS S TS LN LI 1

KNOBG OUTPUT VOL. OUTPUT VOL.

The front panel LEVEL controls are displayed as FRONT PANEL KNOBS
KNOB 1 to 4 (or 1 to 6, depending on models). To the

KNOE1 OUTPUT VOL.
right of each of them is displayed the value - INPUT VOL.
(=position) of the front panel LEVEL hardware knob, - ¥ OUTPUT VOL.
read in real time, from O to 100 (in this example 58, KNOE4 OUTPUT VOL.
28, 2, etc)) KNOES OUTPUT VOL.

KNORG DUTPUT VOL.

For each of them, the drop-down menu allows to
select the control function of certain audio inputs or outputs of the unit:

After selecting the type of volume control (INPUTs or OUTPUTSs), the inputs or outputs
simultaneously affected by each control knob have to be checked in boxes 1, 2, 3, 4, 5 and
6. Clicking with the mouse activates (green) or deactivates them. In the above example, we
see the following control settings:

e LEVEL 1 controls the inputs 1 and 2 levels
e LEVEL 2 controls the inputs 3 and 4 levels
e LEVEL 3 controls the input 5 level

e LEVEL 4 controls the outputs 3 and 4 levels
e LEVEL 5 controls the output 2 level

e LEVEL 6 controls the output 6 level

I ALEVEL control can simultaneously control multiple inputs and outputs, but NOT
the other way around: the application automatically manages that one input or output

is associated with a single control knob, and not simultaneously with several ones

2’01
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The unit's GPI ports (0-10 VDC control ports) on the rear panel are displayed as GPI 1 to 4
(or 1 to 6, depending on models). To the right of each of them is displayed the value of the

signal (voltage) received on the central pin of each GPI port, read in real time (0 to 100
scale). A WPmVOL / WPaVOL or WPMVOL-SR / WPaVOL-SR wall panel, or similar,

connected to a GPI will deliver this full range, O to 100 values, when gestured.

For each of them, the drop-down menu allows to select the control function from the

following options:

PRESETS
INPUT VOL.
OUTPUT VOL.

SOURCE SEL.
+ PRESETS
OUTPUT VOL.

OUTPUT VOL.

INPUT VOL.: volume control of one or more audio inputs of the unit. The boxes of
the targeted inputs must be checked: clicking with the mouse activates (green) or
deactivates them. In the following example GPI #2 controls the volume of inputs 1
and 2:

GPIs

GFIl (1] PRESETS
GFiz 0 INPUT WOL.

OUTPUT VOL.: volume control of one or more audio outputs of the unit. The boxes
of the targeted outputs must be checked: clicking with the mouse activates (green)
or deactivates them. In the following example GPI| #4 controls the volume of the
outputs 1, 3, 4 and 6:

PRESETS

INPUT VOL.

INPUT VOL.
OUTPUT VOL.

2’01
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e SOURCE SEL.: selection of input sources for one or more-unit channels, using the
5-positions selector knob of a WPmMVOL-SR / WPaVOL-SR or similar wall panel.
The boxes of the inputs composing the carousel of selectable sound sources
(INPUTS, upper half of the boxes to the right of the drop-down menu), and the
outputs that will be affected by this selection of sources (OUTPUTS, lower half of

the boxes to the right of the drop-down menu) must be checked: clicking with the

mouse activates (green) or deactivates them.

From the following example, we can deduce the following configuration:

PRESETS
INPUT WOIL.
SOURCE SEL.
OUTPUT VOL.
SOURCE SEL.

.
-
.
-
.
-
.
-
.
-
.
-

OUTPUT VOL.

o GPI3: allows to select sound sources for outputs 2 and 3. The sound sources
are selected using the selector knob of a WPmMVOL-SR / WPaVOL-SR unit,

connected to GPI3, as follows:

Position 0: OFF (no source)
Position 1: input 1
Position 2: input 3
Position 3: input 4
Position 4: input 6

o GPI5: allows to select sound sources for outputs 4 and 6. The sound sources
are selected using the selector knob of a WPmMVOL-SR / WPaVOL-SR unit,

connected to GPI5, as follows:

Position 0: OFF (no source)
Position 1: input 1

Position 2: input 2

Position 3: input 5

Position 4: OFF

-

! The carousel of options for one of these selector knobs may include a

maximum of 4 inputs, so that the first position of the hardware selector (WPaVOL-

SR or similar) corresponds to OFF (no input selected). The next positions, up to a

maximum of 4, consecutively correspond to the inputs being part of the carousel of

selectable sound sources (INPUTS, upper half of the boxes to the right of the drop-

down menu). If less than 4 options are selected, the last selector positions without

associated input also correspond to the OFF selection (no input), as with the GPI 5 in

\the example above.
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the same input or output, both are concatenated ("in series"), so that the highest
level of one of them at a given time will determine the maximum volume control

that can reach the other when set to its maximum position. Examples, with KNOB

When a LEVEL control and a GPI are associated to control the volume of

1 and GPI 1 controlling the channel 2 volume:

e PRESETS: recall of one of the five presets in the NXA memory, using the 5-way

GPI 1 at 100%: moving LEVEL 1 can control the channel 2 volume from O to

100%

KNOB 1 al 100%: acting on GPI 1 can control the channel 2 volume from O

to 100%

GPI 1 at 75%: moving LEVEL 1 can control the channel 2 volume from O to

75%

KNOB 1 at 75%: acting on GPI 1 can control the channel 2 volume from O

to 75%

etc.

selector knob of a WPmMVOL-SR / WPaVOL-SR or similar wall panel.

O

@)

The TAB named VIRTUALS allows to link "A" and "B" VIRTUAL controls of an NXA unit

to virtual buttons and volume controls (faders, knobs) in UCP panels.

VIRTUALS

VIRTUAL1A
VIRTUALZA
VIRTUAL3A
VIRTUAL4A
VIRTUALSA

VIRTUALGA

Selector position O: preset 1 recall
Selector position 1: preset 2 recall
Selector position 2: preset 3 recall
Selector position 3: preset 4 recall

Selector position 4: preset 5 recall

VIRTUALS

SOURCE SEL.
SOURCE SEL.
OQUTPUT VOL.
OUTPUT VOL.
QUTPUT VOL.
OUTPUT VOL.

-
-
-
e
-
-
.
-
-
v
-
-

OUTPUTS

VIRTUALLE

VIRTUALZE

VIRTUAL3E

VIRTUAL4E

VIRTUALSE

VIRTUALGE

99
46

SOURCE VOL.
SOURCE VOL.

2’01
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Options are:

Just control an INPUT or OUTPUT (or group of inputs or outputs) volume with a
virtual fader or rotary knob in a UCP. In this case, just proceed to program "A" virtual
controls, exactly in the same way as the front panel hardware knobs of the NXA,

explained just above these lines:

VIRTUALS

VIRTUALIA T5 INPUT VOL.

VIRTUAL2A 100 OUTPUT VOL.
In this case, "B" virtuals are not available, as won't have any function.

Combined source selector + volume control functions:

o Use a UCP button as a source selector (or input selector) for one or several
output channels (for this purpose use "A" VIRTUALs: 1A, 2A, 3A, 4A, 5A,
6A)

o Volume control of the selected source for the selected destination channels
(for this purpose use "B" VIRTUALSs: 1B, 2B, 3B, 4B, 5B, 6B)

~

/5 You can create UCP panels that include virtual controls for the above
pdrpose, like in this example: a control panel that will allow the user to select a
sound source from 4 choices and adjust the volume at which this source will be
played in a given output zone. This is equivalent to selecting an input from 4 options

and adjusting the matrix "crosspoint" level of the selected source for the desired

Qhannel or channels in an NXA unit: /

Office #1 Music Selector

HOME CINEMA MEDIA SERVER %

WHITE iPOD BLACK iPOD

2’01
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In the following example, the NXA VIRTUALS section is programmed like this, selecting for
each "A" virtual control which INPUTS will make part of the selection list (IN1, 2, 3 and 4
in the example, seen as green boxes) and for which channel (or NXA's outputs) will be this

selection effective (just one channel or OUTPUT in the example, seen as green box):

VIRTUALS

VIRTUALS

VIRTUALIA SOURCE SEL. VIRTUALIE Bl SOURCE VOL.

VIRTUALZA SOURCE SEL. VIRTUAL2E 89 SOURCE VOL.
VIRTUAL3A OUTPUT VOL. VIRTUAL3E
VIRTUAL4A OUTPUT VOL. VIRTUAL4E
VIRTUALSA OUTPUT VOL. VIRTUALSE

VIRTUALGA OUTPUT VOL. VIRTUALGE

@ O 4@ O O O

In the above example, the configuration shows:

¢ VIRTUAL 1A allows to select IN1, 2, 3 or 4 as a sound source for output channel 1,
and VIRTUAL 1B allows to adjust the volume of the selected source for output
channel 1

e VIRTUAL 2A allows to select IN1, 2, 3 or 4 as a sound source for output channel 2,
and VIRTUAL 2B allows to adjust the volume of the selected source for output

channel 2

...we can the build one panel to manage music sources and volume for OUT1, connected to
the loudspeakers in an office, Office #1, and another panel to manage the same for OUT?2,

connected to the loudspeakers in Office #2, like these ones:

Office #1 Music Selector Office 2 Music Selector

HOME CINEMA MEDIA SERVER E HOME CINEMA MEDIA SERVER %

WHITE iPOD BLACK iPOD WHITE iPOD BLACK iPOD

103roydd NN3NW SMOANIM
1X31NOD
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3791LVdWOD
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Positioning the mouse cursor on top of each green rectangle a tooltip will appear, indicating
the numerical value of the virtual control that will select this source for this channel:

- -

VIRTUALS

2’01

. - KPLUTS
VIRTUALIA 75 : SUTPUTE

; NPUTS
VIRTUALZA 100 OUTPUTS

VIRTUALIA 16 OUTPUT VOL.

S31O0N 3SVv3ITad
L)
NOILONAOYLNI

In the above example, these values are:
IN1:25 / IN2:50 / IN3:75 / [IN4:100

...and the picture shows this information as well:

dvaiool
B
SNN3INW

e the NXA channel affected by this source selection with VIRTUAL 1A will be

OUTPUT1 3
e the NXA channel affected by this source selection with VIRTUAL 2A will be g %
OUTPUT2 v
Then, virtual buttons to select sources (IN1 to IN4) in the UCP panel for OUTPUT1 (Office o
1) must be programmed linking them to VIRTUAL 1A, like this é %
e

Office #1 Music Selector

123roydd
SEINIETRE

HOME CINEMA MEDIA SERVER
Invalid Object Name
Devices/NXA_unit/Virtual /Virtual 1A

v 0

25 WHITE iPOD BLACK iPOD o (@)

m Z

s»

Q=

eE

m

[

er (10.0 == Panel Page : OF1 g ()]

Invalid ObjectName  &uTTO F s o e R > %

Control 112 p 8

) - : n

MEDIASERVER 5 Office #1 Music Selector 2
Bl Invalid Object Name T

(@l ]

o)

=

HOME CINEMA MEDIA SERVER

Invalid Object Name

/Devices/NXA_unit/Virtual /Virtual 1A

WHITE iPOD BLACK iPOD
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== Panel Page : OF1

Invalid Object Name « E-n . - '12 & |—a
- H ‘ o
Invalid Object Name f »

SRR 0 Office #1 Music Selector

Control 112

WHITE iPOD

HOME CINEMA MEDIA SERVER

Type
Name Invalid Object Name
Param [ /Devices/NXA_UNIT/Virtual /Virtual1A WHITE iPOD BLACK iPOD
Push Only ¥

2’01

Project Explorer (10.0.1.15 - Local)
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B nvalid Object Name . = ),
&5
Control 112

Control 112 Office #1 MUSIC SelectOf

WHITE iPOD

HOME CINEMA MEDIA SERVER

Invalid Object Name

dvaiool
B
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n _/Devices/NXA_unit/Virtual /Virtual 1A

WHITE iPOD BLACK iPOD

Visible
Locked

X

SMOANIM
ddv

Y

Width

Height

NN3IN
1X31INOD

And the fader to control the selected source in the above panel must be linked to VIRTUAL
1B, like this:

== Panel Page : OF1

Valume Channel 5 FADE - T »
RS —— ! s u ’,Q < B
Invalid Object Name } O

123roydd
SEINIETRE

Vumeter Channel 5 (post) VUMET Office #1 Music Selector

ontre 2 (@]

Control 112 o o)

LhmaE =

=3

HOME CINEMA MEDIA SERVER l'nl'l =

n O

-

Volume Channel 5 m
/Devices [NXA_unit/Virtual /Virtual 1B

g WHITE iPOD BLACK iPOD c

100 >0

m

% Pl

- 0O

v o (ZJ

==

O x

o)
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Now let's repeat all the above for the second UCP panel (Office 2), but this time using
VIRTUALs 2A and 2B:

@ Control 112

Type

Name Invalid Object Name b de i il

/Devices /NXA_unit/Virtual /Virtual2 2

¢

WHITE iPOD

Office 2 Music Selector
e

Name Invalid Object Name HOME CINEMA MEDIA SERVER

Param /Devices/NXA_unit/Virtual /Virtual2 A

Push Only '/

WHITE iPOD BLACK iPOD

....and values 75 and 100 for the other 2 selection buttons. The volume fader for Office #2

UCP panel should be configured like this:

mmw Vumeter Channel 5 (post) VUMETE Oﬁice 2 Music Selector

Volume Channel 5 HOME CINEMA MEDIA SERVER %

[Devices /NXA_unit/Virtual /Virtual2B

WHITE iPOD BLACK iPOD

The third tab here is the DUCKER one. This module gives priority to one of the device's
audio input compared to other active signals in the output channels (zones) chosen as a
destination, attenuating these signals ("override") and thus allowing the diffusion of top

priority audio messages or other content.

DUCKER

.. .
iy .
‘N £ 4 - . « Fem s i, =
M MAX it MAX i : MAX i MAX
INPUT THRESHOLD DEPTH K HOLD RELEASE
60,0 dB i ms 1.000 ms 2.500 ms

NO LAEEL NO LAEEL
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The INPUT selector defines the audio input your microphone, audio player or sound source
will be connected to in order to act as a trigger of the DUCKER function. The list shows the

4 or 6 available inputs, depending on model.

I The NXA series inputs accept line level signals, so the DUCKER function requires
this type of signal from the device to be connected to them.

The destination zone keys in the central part of the section (1 to 4 or 1 to 6, depending on
model) allow selecting the unit's output channels (destination zones) for the DUCKER module
with a mouse click. If a zone is selected (green LED indicator), the DUCKER module will affect

it when the input signal exceeds the activation threshold.

The LED indicator on the left of the module indicates the active or inactive state of the
DUCKER function (activation threshold exceeded). It lights up in green when the DUCKER

function is active.
The module rotary knobs are used to adjust the operation of the DUCKER function:

e THRESHOLD: activation threshold. When the module's input signal (INPUT
selector) exceeds this threshold, the DUCKER function is activated, sending the
signal to the destination zones and attenuating the other audio signals sent to the
same zones (-80 to 0dB)

e DEPTH: attenuation applied on the rest of the signals sent to the destination
zone(s) during the time the DUCKER function is active (0 to 80dB)
e ATTACK: attack time. Determines the time the DUCKER takes to respond when the

level rises above the threshold (activating the attenuation of other signals in the

destination zones). The range extends from 5 ms to 2 sec.

e HOLD: amount of time the DUCKER function remains active once the signal falls

back below the detection threshold. The setting range extends from 10 ms to 3 sec.

e RELEASE: determines the time elapsed until attenuation stops after the time fixed

for HOLD. In this case, the range extends from 50 ms to 3 sec.

201
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6.1.2.3 DEVICE CHANNELS

The detailed view of a NXA device displays the configuration of the unit's 4 or 6 channels

(depending on model). Each channel offers the following parameters and settings:

2’01

6.1.2.3.1 INPUTS

First find the input selection activated for the channel in question, and [t
their relative mixing levels. Here is a picture of the matrix mixer for each cen @ ooae

unit channel. Nt 2470

IN 2 o -15,3 dB

S31ON 3SV3INad
L)
NOILONAOYLNI

With a double click on the knobs, each input can be activated (white
IN 3 -16,0 dB

knob) or muted (grey knob) in the corresponding mixing channel. The
IN 4 -8,3 dB

ins @ oo
ine @ sam

knob setting (click, hold and drag the mouse up / down) defines the level
of each input in the mix.

dvaiool
B
SNNAN

In the example on the right, the channel mix includes the internal
generator (maximum level, O dB), input 1 (-24.7 dB), input 2 (-15.3 dB), input 5 (O dB) and

g
input 6 (-5.3 dB). g >
[ORh+}
5
6.1.2.3.2 VOLUME, SOLO, MUTE, POLARITY
(@]
Volume fader and additional controls: = %
Z
cx
¢ VOLUME: channel volume, adjustable from -infinity to O dB. There are =
two VU-meter bar graphs to the right of the channel fader: the left bar
CLP
displays the channel input signal level and the right one the output @ g g
signal level of the same channel after processing. — 5 ﬁ
e SOLO: mutes all device channels except those whose SOLO function - %
is enabled. § o §
B 2 3
e MUTE: mutes audio for this channel. a 3
n @©
e POLARITY: allows the input signal phase to be inverted (180 degrees m
shift).
3G
>
b3
E
J0
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6.1.2.3.3 CROSSOVER

The CROSSOVER section contains the FILTER TYPE and FREQUENCY parameters for each

of the two filters (low-pass and high-pass) composing the crossover. It splits the audio

frequency spectrum in two parts, creating the two bands generally used in two-way
speakers.

201

e FILTER TYPE: allows you to select the [RHUESSHYIH

. LOW-PASS HIGH-PASS
crossover filter type. You can select one of

YPE

Bessel 24dB/oct

the following filter types. N
600, - * - 5k

o Butterworth 6, 12, 18 or 24dB/oct N
o Bessel 12, 18 or 24dB/oct E:r:mumci!:“: -:F:REQI.IENC\"

1.000 Hz
o Linkwitz-Riley 12 or 24dB/oct

e FREQUENCY: is composed of a potentiometer and a numerical value to adjust the

filter cut-off frequency within the 20Hz - 20kHz range.

S310N 3SV33d

d4vaiool

NOILONAOYLNI

SNNAN

6.1.2.3.4 PARAMETRIC EQ

This section groups the eight parametric filters available per channel, very useful for a

SMOANIM

ddv

precise correction of the frequency response.

Available parameters are described below (the parameters are always displayed for one of
the 8 filters, the one with white background for its number indicator, as filter #2 in the

image):

e ON/OFF: turns on/off the parametric EQ, affecting all filters from this section. When
it is OFF (top left button greyed out), there is no filter processing (all filters are
bypassed). In the opposite case (green button), operation is determined by the other

parameters.

e FILTER TYPE: type of filter used. You can select one of the following filter types

(adjustable controls for each filter type are shown between brackets):

S321A3a
37191LVdWOD

NN3INW
1X31INOD

123rodd

IBN43193

o Bypass: filter not used.

o Parametric EQ (FREQUENCY, GAIN, Q): classic parametric equalizer filter
with adjustable central frequency (between 20Hz and 20kHz), central
frequency gain or attenuation (between +12dB and 60dB) and bandwidth
(1/Q, Q between 0.3 and 200).

o Low-Shelf and High-Shelf with a 6 or 12 dB/oct slope (FREQUENCY,
GAIN): shelving type filters with adjustable cut-off frequency (between
20Hz and 20kHz) and gain or attenuation (between +12dB and —60dB).

o Low-Pass and High-Pass with a 6 or 12 dB/oct slope (FREQUENCY):

these are low-pass and high-pass filters with adjustable cut-off frequency
(between 20Hz and 20kHz).

(don) s1aNvd
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o All-Pass order 1 and 2 (FREQUENCY, Q in order 2): all-pass filters that do
not affect the signal amplitude, but the phase at certain frequencies (in
contrast with delay, which changes phase at all frequencies). This type of
filter is mainly used to compensate for phase errors in speakers or other

causes, such as phase shifts introduced by the crossover.

(O PARAMETRIC EQ
0] 2

¥PE Parametric EQ

160s = eilk {-¥ Sl

n* 20k M’ MAX M

FREQUENCY GAaIN aQ
106 Hz +8,5d8 12,0

Itis recommended to use the graphical representation of the channel EQ to help you during
the adjustment (Show/Hide Graph icon in the lower right corner of the EclerNet Manager

application window):

From v4 onwards: New EQ export / import feature that allows to export the EQ
section from devices like MIMO88, MIMO88SG, MIMO1212SG, MIMO88 CONFERENCE,

NXA series, etc. to a *.eqs file that can be imported in other devices:

THRESHOLD

(© PARAMETRIC EQ

Import EQ settings...

Export EQ settings...

MO . x
o e Save EQ Settings to
. 4+ « Ecler » EclerNet Man... » v ¢ scar en EclerNet Manager o
. .(, Organizar v Nueva carpeta = 7]
0.0 &
& Papelera de reciclaje o) Nombre Fecha ™
%% Dropbox
bin
MKT
controls hibrary 1 v
DATA BASE PRODUCTS v % >
Nombre: v
Tipe: | *.eqs v
# Ocultar carpetas Guardar Cancelar

e |t's available just when the EQ section is ON

e Exporting an EQ set with 8 filters (for instance, MIMO88 output EQ), for instance,
to a device that supports 6 filters (like NXA units) will result in ignoring filters 7 and
8

2’01

S31ON 3SV3INad
L)
NOILONAOYLNI

dvaiool
B
SNNAN

SMOANIM
ddv

NN3INW
1X31INOD

123rodd
IBN43193

S32IA3a
3791LVdWOD

(don) s1aNvd
T0Y1INOD ¥3SN




) ecLer

6.1.2.3.5 COMPRESSOR

The compressor section offers a dynamic behaviour processing of the channel signal,

allowing the output intensity to be controlled not to exceed certain levels.

Available settings are:

ON/OFF: turns the compressor on/off (green button/grey © COMPRESSOR

button). In OFF mode, the other section controls are disabled. 18.0.0
THRESHOLD: compression threshold. Composed of a .
potentiometer and a numerical value and used to specify the AHRESHOLE

-2,0 dB
input signal level at which compression begins to occur. This

parameter ranges from +18dB to —-36dB. ul"
RATIO
34:1

RATIO: compression ratio. It also includes a potentiometer and
its associated numerical value. This parameter determines the

i i i i i M MAX M MAK
output volume reduction ratio when the input signal level rises L.

7.6 ms 380 ms

above the threshold. A value of 1:1 states that the signal level

does not undergo changes, while the extreme value of inf:1 £ '_-
B HARD T !

represents a signal limiter, with which any signal above the SO MAKEUR

+1,7dB
threshold will be limited to that threshold level.

ATTACK (potentiometer and numerical value): attack time. Determines the time the
compressor takes to respond when the input level rises above the threshold. The

range extends from 0.1 ms to 500 ms.

RELEASE (potentiometer and numerical value): determines how quickly the
compressor stops acting once the signal input level drops below the threshold. In
this case, the range covers from 1msec to 5sec.

KNEE (HARD / SOFT): determines how compression is applied in the transition
zone or "knee" once the compression threshold has been crossed, giving a response
curve with a rounded edge or a